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Get Help

There are a number of ways to learn more about your product and interact with Oracle and other users.

Get Help in the Applications

Some application pages have help icons ® to give you access to contextual help. If you don't see any help icons on
your page, click your user image or name in the global header and select Show Help Icons. If the page has contextual
help, help icons will appear.

Get Training

Increase your knowledge of Oracle Cloud by taking courses at Oracle University.

Join Our Community

Use Cloud Customer Connect to get information from industry experts at Oracle and in the partner community. You
can join forums to connect with other customers, post questions, suggest ideas for product enhancements, and watch
events.

Share Your Feedback

We welcome your feedback about Oracle Applications user assistance. If you need clarification, find an error, or just
want to tell us what you found helpful, we'd like to hear from you.

You can email your feedback to oracle_fusion_applications_help_ww_grp@oracle.com.

Thanks for helping us improve our user assistance!
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1 How do | set up candidate messaging?

Introduction

Scope of this Playbook

This playbook is intended for an HCM application administrator to set up candidate messaging in Recruiting. It also
includes setup and configuration information for two-way candidate communications and Message Center in Recruiting
Booster.

As an administrator, you'll learn how to set up and configure:
- One-way email communications in Recruiting
- One-way SMS communications in Recruiting
- Two-way email communications in Recruiting Booster
- Two-way SMS communications in Recruiting Booster

Message Center in Recruiting Booster

What's Candidate Messaging?

Recruiters and hiring managers can send emails, SMS messages, or both to candidates from Recruiting. They
can send these messages using preconfigured email or SMS templates, or by creating messages from scratch. All
communications to candidates regarding their applications, interviews, job offers can be delivered using these channels.

The preconfigured email and SMS templates are available in the Recruiting Content Library for different types of
notifications such as Candidate Job Application Notification, Hiring Team Notification, and so on.

One-Way Candidate Communications

One-way candidate communications refers to the ability to send email and SMS messages to external candidates

and emails to internal candidates. Recruiters and hiring managers can create an email or text message to start a
conversation with an external or internal candidate about their job applications, interviews, job offers, or have any casual
conversation with them.

A Messages tab is available in candidate job applications, prospect records, candidate profiles, candidates in candidate
pools.

Two-Way Candidate Communications

Two-way candidate communications refers to the ability to not only send outgoing messages but also receive incoming
messages from candidates. The two-way communications feature is available when Recruiting Booster is enabled.

Using this feature, recruiters and hiring managers can start a conversation with a candidate through email, SMS, or both
and also receive their replies. The hiring team can also reply to messages received from candidates. The hiring team can
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send and reply to email and SMS messages from the Messages tab in Recruiting. They can also send emails through
their own email application (such as Microsoft Outlook, Gmail, Mozilla Thunderbird).

All messages across the application such as job application confirmation, invitation to apply, interviews, and job offers
can be viewed from the Messages tab.

Candidates can start an email conversation as long as they know the company’s vanity email address.

- If the candidate is available in Oracle Recruiting, that communication is saved as part of the candidate's
profile. The hiring team can later reply to that candidate communication from Oracle Recruiting. Note that this
communication can’t be attached to any job application as there's no context to that communication started by
the candidate.

- If the incoming email isn't associated with any candidate, then the message is discarded.

Note: Two-way communication with SMS currently works with Twilio and Syniverse providers only. As an
administrator, make sure that the proper provider setup is done before you enable two-way communication. For two-
way SMS communication to work correctly, you need to have a long code number that supports accepting incoming
messages.

Message Center

When the Redwood experience is enabled in Recruiting Booster, recruiters and hiring managers can have a consolidated
view of all communications exchanged with a candidate in any context through a centralized messaging hub called
Message Center. This is available on the Messages tab, in My Client Groups > Hiring. The hiring team can send and
reply to messages from this tab.

Choosing Between Email and SMS

By default, candidate communications are delivered through email. However, as an administrator, you can configure
and enable the SMS communications feature in Setup and Maintenance.

When this feature is enabled, the application allows candidates to register or sign in using either their email or phone
number. When it's not enabled, candidates will always register using their email and they will receive emails by default.

The candidate’s preferred communication channel is decided by the method they use during their initial job application:

- If they register with their phone number, SMS becomes their preferred communication channel. They receive
only SMS messages and not emails, until they change their preferences.

- If they register with an email address, email becomes their preferred communication channel. They continue to
receive only emails and not SMS messages, until they change their preferences.

- After they sign in, candidates have the option to opt in for both email and SMS as their preferred
communication channels. In this case, they receive both SMS messages and emails.

When SMS communications is enabled, the following rules apply:

- If you're using preconfigured templates from the Recruiting Content Library, and they contain both email and
SMS content, candidates will receive messages according to their communication preferences.

- If the organization decides to send only emails to candidates, the SMS message content in the Recruiting
Content Library must be empty. In this case, candidates will receive emails even if SMS is their preferred
communication method.
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What Types of Email Addresses Are Used?

A recruiter or hiring manager can use two different email addresses for their email communications with external and
internal candidates.

- Vanity email: A vanity email is used to brand the "from email" to make it friendlier and easy to read. This email
can be used when your organization wants to track candidate communications in Recruiting.

o Vanity email is a prerequisite for enabling two-way communication. We use a dedicated vanity email box
to send emails to candidates and receive their replies.

No-reply email: The no-reply email can be used when your organization doesn’t need to track or process
replies sent by candidates. Automated notifications related to job alerts, campaigns, or candidate verifications
(containing the PIN number) are usually sent using the no-reply email.

To take advantage of these features, it's recommended to use separate mailboxes for the vanity email and no-reply
email.

SMS Setup

Workflow to Set Up One-Way SMS Communications

Here are the steps to set up one-way SMS communications in Recruiting, which enables the hiring team to send
outgoing SMS messages to internal and external candidates.

Required Steps
1. Add an SMS Messaging Provider

2. Enable SMS Communications and Set Limits for Outbound SMS

Optional Steps

Although these steps are optional, it's recommended to complete them:
« Block Phone Numbers or Phone Number Patterns
Configure List of Countries to Send SMS Messages
- Enable Candidates to Opt Out of SMS Messages

Related Topics
« Profile Options for Messaging
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Workflow to Set Up Two-Way SMS Communications

Here are the steps to set up two-way SMS communications when Recruiting Booster is enabled. This enables the hiring
team to send and receive SMS messages to and from internal and external candidates.

Required Steps

Opt in to Recruiting Booster

Add an SMS Messaging Provider

Enable SMS Communications and Set Limits for Outbound SMS
Enable Two-Way Communications on Active SMS Messaging Provider
Configure the Profile Option to Read SMS from a Given Start Date
Run the Scheduled Process for Inbound Messages

cuhAhUNRA

Optional Steps

Although these steps are optional, it's recommended to complete them:
« Configure the Text Assistant
- Add an SMS Messaging Provider for the Text Assistant
« Block Phone Numbers or Phone Number Patterns
« Configure List of Countries to Send SMS Messages
- Enable Candidates to Opt Out of SMS Messages
« Set Up Email Notifications for Candidate SMS Replies

Related Topics
« Profile Options for Messaging

Workflow to Set Up the Text Assistant

Here are the steps to set up the Text Assistant in Recruiting, which enables candidates to interact with the Career Coach
agent through SMS.

Required Steps

1. Enable the Career Coach Agent for Career Sites
2. Configure the Text Assistant
3. Add an SMS Messaging Provider for the Text Assistant

Optional Step

1. Configure Profile Options for the Text Assistant
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Set Up One-Way SMS Communications

Add an SMS Messaging Provider

You need to create and activate a messaging provider that will be used for communicating with candidates using SMS.

Please ensure that SMS configurations are different for each pod—production and other test pods.

1. In the Setup and Maintenance work area, go to:
o Offering: Recruiting and Candidate Experience

o Functional Area: Recruiting and Candidate Experience Management
o Task: Recruiting Messaging Configuration

On the Recruiting Messaging Configuration page, in the SMS Messaging Providers section, select Add.
Enter a name and description.
Select a provider.

LI U

Based on the provider you selected, enter info in the Request Details, Authentication, Headers, and Body sections.
For details, see the document Examples of Adding an SMS Provider on My Oracle Support (ID 2657006.1).

Note: For processing outbound messages, the SMS messaging provider's APl is expected to return the response
in JSON format. To ensure smooth processing of these messages, we recommend that you include the Accept
header in the Headers section and specify its value as application/json.

6. Select Test Outbound Message to send a test message and make sure that the configuration is properly done.
7. Select Save and Close.
8. On the SMS Messaging Providers list, set the provider you added to Active.

Enable SMS Communications and Set Limits for Outbound SMS

When you enable SMS communications, candidates can apply for jobs and review their profile in their candidate self-
service using their phone number. The Recruiting Content Library provides SMS message templates in addition to
existing email templates.

Before you start

- Atleast one active messaging provider is needed to enable SMS communications.
- Avalid SMS provider license is required before you enable the SMS communications.

- You can select Twilio, Syniverse, or any other SMS provider whose services can be initiated using REST services.
You should use the SMS provider’s developer documentation to configure the services and account credentials
needed in the Recruiting product.

- When enabling SMS communications, you need to set limits for SMS messages that can be sent across
Recruiting to all candidates and the number of messages that can be sent to each candidate in a day. If you're
enabling SMS communications for the first time, you can enable it only if you set these limits. If you already
enabled SMS communications in the past, but didn’t specify SMS limits, you'll now see predefined limits set
based on your past usage. If you already enabled SMS communications and specified SMS limits in the past,
those limits will continue to apply. This feature is useful to limit the volume of outbound text messages sent
using third party services like Twilio or Syniverse. It also helps limit the cost of usage based service and prevent
unexpected spikes in cost.
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Here's what to do

1. Inthe Setup and Maintenance work area, go to:
o Offering: Recruiting and Candidate Experience

o Functional Area: Recruiting and Candidate Experience Management
o Task: Recruiting Messaging Configuration

2. In the Limit for SMS and WhatsApp Messages section, select Edit.
3. Configure all these options in the SMS Limits column:

o Maximum number of messages that can be sent in a day: This defines the total number of messages
that can be sent from Recruiting in a day across all candidates by different hiring team members. This
is called the system hard limit. All messages that are sent after this limit is reached are blocked for that
day and appear in the Messages tab as Blocked. When this limit is reached, a notification is sent to the
administrator. Blocked messages are never attempted to be sent automatically to the candidate.

o Maximum number of messages that can be sent per candidate in a day: This defines the number of
messages that can be sent to a single candidate in a day by different hiring team members. This is also
called as the candidate message limit. All messages that are sent after this limit is reached are blocked for
that day and appear in the Messages tab as Blocked. Blocked messages are never attempted to be sent
automatically to the candidate.

o Number of messages that triggers a warning notification: This defines the number of messages that can be
sent across Recruiting. This is called the system soft limit. After this number is reached, a warning email is
sent to the administrator. This number should be less than the maximum limit that can be sent in a day.

o Email for notifications: This is the email address to which warning emails are sent. By default, it's auto-
populated with a nonworking email address. You must change it to a valid email address, such as the
administrator's email who can receive the notifications.

Note:
o UTC time zone is considered when counting the limits.
o The system hard limit and candidate message limit are reset to zero at the start of UTC day, at 00:00:00

hours. When the limits are reset, you can send new messages the next day. If you're using the Redwood
version of Recruiting, you can resend the blocked messages the next day from the Messages tab.

o Candidates will be informed through the career site when the system hard limit or the candidate
message limit is reached for the day.

o Recruiters can’t send messages manually when the system hard limit or the candidate message limit is
reached. If automated messages are initiated, they go to the Blocked status.

4. Select Save.

5. On the Recruiting Messaging Configuration page, in the SMS Messaging Providers section, select the option Enable
SMS Communications.

Related Topics
 Limit Volume of Outbound SMS Messages
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Set Up Two-Way SMS Communications

Opt in to Recruiting Booster

To enable Recruiting Booster and its functionalities, you first need to opt in to Recruiting Booster.

Before you start
You need these privileges to opt in:
Review Applications Offering (ASM_REVIEW_APPLICATIONS_OFFERINGS_PRIV)
- Configure Oracle Fusion Applications Offering (ASM_CONFIGURE_OFFERING_PRIV)

Here's what to do

1. In the Setup and Maintenance work area, select the Recruiting and Candidate Experience offering.
2. Select Change Feature Opt In.

3. On the Opt In: Recruiting and Candidate Experience page, enable Recruiting Booster.

4. Select Done.

Add an SMS Messaging Provider

You need to create and activate a messaging provider that will be used for communicating with candidates using SMS.

Please ensure that SMS configurations are different for each pod—production and other test pods.
1. In the Setup and Maintenance work area, go to:
o Offering: Recruiting and Candidate Experience
o Functional Area: Recruiting and Candidate Experience Management
o Task: Recruiting Messaging Configuration
On the Recruiting Messaging Configuration page, in the SMS Messaging Providers section, select Add.
Enter a name and description.
Select a provider.

Based on the provider you selected, enter info in the Request Details, Authentication, Headers, and Body sections.
For details, see the document Examples of Adding an SMS Provider on My Oracle Support (ID 2657006.1).

v oA BN

Note: For processing outbound messages, the SMS messaging provider's APl is expected to return the response
in JSON format. To ensure smooth processing of these messages, we recommend that you include the Accept
header in the Headers section and specify its value as application/json.

6. Select Test Outbound Message to send a test message and make sure that the configuration is properly done.
7. Select Save and Close.
8. On the SMS Messaging Providers list, set the provider you added to Active.

Enable SMS Communications and Set Limits for Outbound SMS

When you enable SMS communications, candidates can apply for jobs and review their profile in their candidate self-
service using their phone number. The Recruiting Content Library provides SMS message templates in addition to
existing email templates.
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Before you start

- At least one active messaging provider is needed to enable SMS communications.

- A valid SMS provider license is required before you enable the SMS communications.

You can select Twilio, Syniverse, or any other SMS provider whose services can be initiated using REST services.
You should use the SMS provider’s developer documentation to configure the services and account credentials
needed in the Recruiting product.

- When enabling SMS communications, you need to set limits for SMS messages that can be sent across
Recruiting to all candidates and the number of messages that can be sent to each candidate in a day. If you're
enabling SMS communications for the first time, you can enable it only if you set these limits. If you already
enabled SMS communications in the past, but didn’t specify SMS limits, you'll now see predefined limits set
based on your past usage. If you already enabled SMS communications and specified SMS limits in the past,
those limits will continue to apply. This feature is useful to limit the volume of outbound text messages sent
using third party services like Twilio or Syniverse. It also helps limit the cost of usage based service and prevent
unexpected spikes in cost.

Here's what to do

1. In the Setup and Maintenance work area, go to:
o Offering: Recruiting and Candidate Experience

o Functional Area: Recruiting and Candidate Experience Management
o Task: Recruiting Messaging Configuration

2. Inthe Limit for SMS and WhatsApp Messages section, select Edit.
3. Configure all these options in the SMS Limits column:

o Maximum number of messages that can be sent in a day: This defines the total number of messages
that can be sent from Recruiting in a day across all candidates by different hiring team members. This
is called the system hard limit. All messages that are sent after this limit is reached are blocked for that
day and appear in the Messages tab as Blocked. When this limit is reached, a notification is sent to the
administrator. Blocked messages are never attempted to be sent automatically to the candidate.

o Maximum number of messages that can be sent per candidate in a day: This defines the number of
messages that can be sent to a single candidate in a day by different hiring team members. This is also
called as the candidate message limit. All messages that are sent after this limit is reached are blocked for
that day and appear in the Messages tab as Blocked. Blocked messages are never attempted to be sent
automatically to the candidate.

o Number of messages that triggers a warning notification: This defines the number of messages that can be
sent across Recruiting. This is called the system soft limit. After this number is reached, a warning email is
sent to the administrator. This number should be less than the maximum limit that can be sent in a day.
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o Email for notifications: This is the email address to which warning emails are sent. By default, it's auto-
populated with a nonworking email address. You must change it to a valid email address, such as the
administrator's email who can receive the notifications.

Note:
o UTC time zone is considered when counting the limits.
o The system hard limit and candidate message limit are reset to zero at the start of UTC day, at 00:00:00

hours. When the limits are reset, you can send new messages the next day. If you're using the Redwood
version of Recruiting, you can resend the blocked messages the next day from the Messages tab.

o Candidates will be informed through the career site when the system hard limit or the candidate
message limit is reached for the day.

o Recruiters can’t send messages manually when the system hard limit or the candidate message limit is
reached. If automated messages are initiated, they go to the Blocked status.

4. Select Save.

5. On the Recruiting Messaging Configuration page, in the SMS Messaging Providers section, select the option Enable
SMS Communications.

Related Topics
« Limit Volume of Outbound SMS Messages

Enable Two-Way Communications on Active SMS Messaging Provider
You need to enable the two-way SMS communications feature.

Before you start

- Atleast one SMS provider needs to be Active.
« SMS communications should be enabled.

- The phone number that you use for two-way communications must support incoming SMS messages.

Here's what to do

1. Open the new provider you created, and select the option Enable Two-Way SMS Communications.
2. Select Test Inbound Message to make sure that the configuration is properly done.
3. Select Save and Close.

Configure the Profile Option to Read SMS from a Given Start Date

You can configure a profile option called ORA_IRC_2_WAY_SMS_LAST_SYNC_TIME to read SMS messages from a
specific start date and time.

When you enable two-way SMS communications, this profile option is automatically set to the date and time when you
enabled the feature. The Recruiting application will start processing SMS messages that were received from that date
and time onward.

This profile option is referenced by the Process Recruiting Inbound Message scheduled process, which updates the date
and time automatically to the current date and time when it completes running. So, for example, if the profile option
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value was initially set to a date last week, and the scheduled process runs today, SMS messages will be processed from
last week until today. After the scheduled process completes running, it'll set the profile option value to today's date.
This will ensure that messages will be read from today onward, when the scheduled process runs next time.

If you need to read SMS messages from a different date and time, you can manually update this profile option value.
This set up step is optional.

In the Setup and Maintenance work area, select the Tasks icon.

Select Search.

On the Search page, search for the task Manage Administrator Profile Values.
. Select the task name.

A WN B

On the Manage Administrator Profile Values page, search for the profile option
code IRC_2_WAY_SMS_LAST_SYNC_TIME.

Set the profile value to the desired start date and time from which SMS messages should be read. It's recommended
to set this value to five days before the current date. Use the UTC date and time in standard ISO 8601 format: YYYY-
MM-DD HH:MM:SS to enter the value.

o

Note: In the case of Twilio, if you set this value to a date beyond 400 days in the past, it will automatically default
to 400 days in the past.

7. Select Save and Close.

Run the Scheduled Process for Inbound Messages

You need to run the Process Recruiting Inbound Message scheduled process with a 15-minute frequency to see
candidates' SMS and email replies.

From the navigation menu, go to Tools > Scheduled Processes

On the Overview page, select Schedule New Process.

On the Schedule New Process page, select the menu and select Search.
Search for the Process Recruiting Inbound Message process.

Select OK.

On the Process Details page, submit the process.

ou AN

Set Up the Text Assistant

Enable the Career Coach Agent for Career Sites
You must enable the Career Coach agent for a career site, if you haven't already done so.

This agent is available as both a predefined agent and a template. If you wish to configure the agent, you need to create
a copy of the template.

For more details on enabling or configuring the agent, see the document, Enable Al Agent for Career Sites (MOS KB
873870) on My Oracle Support.

When you enable this agent for an SMS provider, the predefined agent code ORA_CAREER_COACH will be used by
default in Setup and Maintenance. You must change this code if you've created a copy of the template and configured it.

10
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Limits for Text Assistant Messages

Setting limits for outbound text assistant messages is necessary to maintain system stability, protect service
availability for all users, control infrastructure costs, and reduce the risk of misuse (for example, spam or unauthorized
automation). These limits include:

- Maximum number of text assistant messages that can be sent to all users (including candidates and visitors)
per day — This is called the agent system hard limit. This represents the maximum number of agent calls that
are made for all users in a day.

- Maximum number of text assistant messages that can be sent to a candidate or visitor per day — This is called
the agent candidate limit. This represents the maximum number of agent calls that are made in a day for a
single candidate or visitor.

The following threshold limits will be modified to include the text assistant limits, in addition to the recruiter and auto-
generated limits:

- System hard limit - The maximum number of all types of messages that can be sent across all candidates in a
day.

- Candidate message limit — The maximum number of all types of messages that can be sent to each candidate
in a day.

- System soft limit — The number of all types of messages that can be sent across all candidates in a day that
initiates a warning notification.

Note: When the text assistant is enabled, all types of messages include hiring team, auto-generated, and text
assistant messages. When it’s not enabled, they include only hiring team and auto-generated messages.

Here's what happens when one of the above limits is reached:

Table 1: Limits for all users per day

Agent system hard limit System hard limit Result

Reached Not reached Message displayed to the candidate that the
agent is unavailable to respond.

Reached Reached No message is displayed to the candidate.

Not reached Reached No message is displayed to the candidate.

Table 2: Limits for each user per day

Agent candidate limit Candidate message limit Result

Reached Not reached Message displayed to the candidate that the
agent is unavailable to respond.

Reached Reached No message is displayed to the candidate.

n
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Agent candidate limit Candidate message limit Result
Not reached Candidate message limit is available with 1 Message displayed to the candidate that the
message remaining. agent isn't available to respond.

Configure the Text Assistant

Configuring the text assistant involves confirming the agent team code, setting limits for outbound messages, and
enabling visitors to interact with the text assistant.

Before you start

To enable the text assistant in your SMS provider configuration, the following privilege and duty Spectra Authorization
Service (SAS) role should be added to the Webhook user role:

+ Privilege: IRC_REST_SERVICE_ACCESS_INBOUND_SMS_WEBHOOK_PRIV
« Duty SAS role: ORA_DR_HCM_IRC_CE_AGENT_ACCESS_DUTY

For details, see Webhook Setup for Two-Way SMS Communications. Note that the text assistant responds to incoming
messages that are processed by Webhook only. It doesn't respond to incoming messages processed by the Process
Recruiting Inbound Message scheduled process.

To understand the text assistant threshold limits, see Limits for Text Assistant Messages.

Here's what to do

1. In the Setup and Maintenance work area, go to:
o Offering: Recruiting and Candidate Experience
o Functional Area: Recruiting and Candidate Experience Management
o Task: Recruiting Messaging Configuration

2. In the Daily Limits for SMS and WhatsApp Messages section, select Edit.
3. Configure these options in the SMS Limits column:
o Maximum number of text assistant messages to send across all candidates: This is the agent system
hard limit. Any candidate conversations initiated after this limit is reached won't be processed by the agent.
Note that any pending conversations with the candidate won’t be continued the next day. The candidate
has to initiate a fresh conversation. When this limit is reached, a notification is sent to the administrator.
o Maximum number of text assistant messages to send to each candidate: This is the agent candidate
limit. Any candidate conversations initiated after this limit is reached won't be processed by the agent.
When this limit is reached, a notification is sent to the administrator.

Note:
o UTC time zone is considered when counting the limits.

o These limits are reset to zero at the start of UTC day, at 00:00:00 hours. When the limits are reset,
candidates can initiate fresh conversations with the text assistant.

4. Select Save.

5. On the Recruiting Messaging Configuration page, in the Text Assistant section, ensure that the Agent Team Code
field has a value of ORA_CAREER_COACH.

12
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If you've made any changes to the Career Coach template in Al Agent Studio, copy the agent team code from there
and enter it here.

6. In the Additional Communication Settings section, enable visitors to send messages.

Add an SMS Messaging Provider for the Text Assistant

You need to create and activate a messaging provider that will be used for communicating with candidates using the
text assistant.

If you already have an active SMS provider with SMS communication enabled, and you edit the provider to enable agent
communication, the SMS communication will be disabled. You'll then need to enter the text assistant threshold limits
and re-enable SMS communication.

Please ensure that SMS configurations are different for each pod—production and other test pods.

1. Inthe Setup and Maintenance work area, go to:
o Offering: Recruiting and Candidate Experience

o Functional Area: Recruiting and Candidate Experience Management
o Task: Recruiting Messaging Configuration
On the Recruiting Messaging Configuration page, in the SMS Messaging Providers section, select Add.

Enter a name and description.
. Select a provider.

“ oA BN

Enter the maximum limit for a message length, in number of characters.

The Body parameter includes the full text of the message you want to send. For Twilio, it's limited to 1600 characters.
Based on your business needs, you can set the message length limit to 1600 characters or less.

6. Select Enable two-way SMS communications to allow candidates to reply to SMS messages.
7. Select Enable the candidate text assistant if you want the text assistant to automatically respond to candidate SMS
messages.

When you do this, you'll see two tabs displayed, where you can define the details for two SMS channels: The
Hiring Team Messages tab is for the first channel that's used for SMS messages sent by the recruiting team. The
Automated and Text Assistant Messages tab is for the second channel that's used for automated messages and
text assistant responses.

8. Enter info in the Request Details, Authentication, Headers, and Body sections for the selected service provider in
both tabs.

For more information on entering info for the Twilio and Syniverse service providers, see the document Examples of
Adding SMS Providers for the Text Assistant on My Oracle Support (KB38155).

Note:

o For processing outbound messages, the SMS messaging provider's APl is expected to return the
response in JSON format. To ensure smooth processing of these messages, we recommend that you
include the Accept header in the Headers section and specify its value as application/json.

9. Select Test Outbound Message to send a test message and make sure that the configuration is properly done.
10.You need to test the outbound message for each channel type, hiring team and agent messages.

In the SMS Message Info section, enter the phone number for each channel and select the channel type.
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11. Save and close the page once the test is successful.

Configure Profile Options for the Text Assistant

You can optionally configure the following profile options for the text assistant:

Feature

Number of seconds to wait for the
text assistant to respond to the
candidate's message. If the text
assistant is unable to reply within
this time, the candidate is notified
that the agent is unavailable.

This profile option must be created
and then set to the desired value.

The time period for a conversation
to be considered active. Within
this time period, the conversation
between the text assistant and the
candidate are considered as part
of the same session and there's
continuity in the text assistant

responses. If the candidate responds

after this time period elapses, the
text assistant won't continue the
conversation but instead start a
fresh conversation.

Related Topics

Profile Option

IRC_TEXT_AGENT_MAX_RESPONSE_TIME

ORA_IRC_TEXT_AGENT_ACTIVE_SESSION

- Create and Edit Profile Options

Optional Configuration for SMS

Block Phone Numbers or Phone Number Patterns

Chapter 1

How do | set up candidate messaging?

Profile Value

Enter the number of seconds. The
default value is 120 seconds.

The default value is 4 hours.

You can prevent sending SMS or WhatsApp messages to unauthorized phone numbers by blocking those numbers
or by blocking those numbers that match a specific pattern. After you add the blocked list, any SMS or WhatsApp
messages that are sent to these numbers or patterns will be blocked in Recruiting. You can see the Blocked status and

the reason for the block when you open the SMS or WhatsApp message.

An error message is displayed to candidates on the career site when they provide a number that's on the blocked

numbers and patterns list.

To enable this feature, you need to add the phone numbers or phone number patterns to a CSV file, compress the file,

and then upload it using the Recruiting Messaging Configuration task.

These are the specifications of the CSV file:

- Each compressed file should contain only one CSV file.

- The file size must not exceed 2 MB.

- You must upload separate files, one for phone numbers and another for phone number patterns.

ORACLE
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Here are a few things to consider about the file used for uploading phone numbers:
- The CSV file must contain only one column and it must not be empty.
If the phone number contains a + sign or a comma or brackets, you must enclose them within double quotes.

- The phone number must include the country code and area code.

Here are a few things to consider about the file used for uploading phone number patterns:
- The CSV file must contain only one column and it must not be empty.

- You need to use regular expression patterns for phone number patterns. For example, to block phone numbers
beginning with 1800, use a regular expression such as 1800. *

Note: Using this task, you can also unblock phone numbers or phone number patterns that were blocked earlier.

1. In the Setup and Maintenance work area, go to:
o Offering: Recruiting and Candidate Experience
o Functional Area: Recruiting and Candidate Experience Management
o Task: Recruiting Messaging Configuration
2. If you haven'’t uploaded phone numbers or phone number patterns so far, you can download a sample file from the
downloadable links available in the Block Phone Numbers or Patterns section. Next, select Edit in this section.
3. From the Manage Phone Numbers or Patterns list, select one of these options:
o Add Phone Numbers: Block phone numbers.
o Add Patterns: Block phone number patterns.
o Delete Phone Numbers: Unblock phone numbers.
o Delete Patterns: Unblock phone number patterns.
4. For each of the above actions, upload a separate CSV file that contains the numbers or patterns. So if you're using a
CSV file to block some phone numbers, you must upload a different CSV file for unblocking some phone numbers.

If you'd blocked some phone numbers earlier, the new phone numbers that you upload now will get added to the
blocked list.

5. Select Save.

What to do next

You can also download the list of blocked phone numbers or phone number patterns by selecting the respective
download links. For SMS messages, you can generate a report from the Reports for Text Messages section in this task to
understand how many SMS messages were blocked per country.

In the Redwood version of Recruiting, you can resend blocked SMS messages, if you unblock the phone numbers or
phone number patterns.

Configure List of Countries to Send SMS Messages

Using the Recruiting Messaging Configuration task, you can define the list of allowed countries that can receive SMS
messages. Earlier, you could define this using the profile option ORA_IRC_SMS_ALLOW_LIST. From upgrade 25A, this
profile option is replaced with the Recruiting Messaging Configuration task. Any country codes that you earlier specified
using the profile option are carried over to the Recruiting Messaging Configuration page. If you're currently sending
SMS messages to countries outside this list, they'll not be sent. An error message is also displayed to candidates on the
career site when they provide a number that's not in this allowed list.
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1. In the Setup and Maintenance work area, go to:
o Offering: Recruiting and Candidate Experience

o Functional Area: Recruiting and Candidate Experience Management
o Task: Recruiting Messaging Configuration

2. Inthe Allowed List of Countries for SMS section, select Edit.
3. Select the Create icon (displayed as +).
4. Select the country from the list that appears.

Note: When you select a country that has the same country code as another country, both countries will be added
to this list. For example, when you select United States, Canada will also be added because it has the same country
code.

5. Select Save.

What to do next

When you configure the list of allowed countries, any text messages that are sent to countries outside of the allowed
list will be blocked in Recruiting. You can see the Blocked status against the message along with the reason for the
block in the Text Messages section of the Messages tab. In the Redwood version of Recruiting, you can resend blocked
messages, after you add that country to the allowed list.

Enable Candidates to Opt Out of SMS Messages

Candidates have the flexibility to opt in or opt out of SMS communications. To stop receiving SMS messages, they
can send an SMS with a STOP keyword or similar. To resume receiving messages, they can send an SMS with a START
keyword or similar.

This feature uses the Webhook functionality and is applicable to Twilio and Syniverse service providers only.

These predefined profile options and values are available by default in the Settings and Maintenance area. The
keywords sent by the candidate to start or stop SMS messages are validated against these profile values.

Profile Option Default Values

ORA_IRC_CAND_SMS_OPTOUT_PATTERN = STOP, STOPALL, UNSUBSCRIBE, CANCEL, END, QUIT

ORA_IRC_CAND_SMS_OPTIN_PATTERN START, UNSTOP

Note: If the service provider has configured an opt-out management feature, the keywords are validated against it.
It's recommended that the keywords specified in the opt-out management feature match these profile values.

Here are a few things to note when a candidate opts out of SMS communications:

- SMS is removed as the preferred communication channel. The Compose button is disabled in the Messages
section in Recruiting.
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If the candidate’s email is verified, it's automatically set as their preferred communication channel. The
candidate is also notified about the change. The email notification is based on this template in the Recruiting
Content Library:

o Category: Candidate Profile Notification

o Content Item Name: Email Notification to Candidate for Updated Communication Channel
o Code: SMS_OPTOUT_CAND_COMM_PREF_UPD

Note: When the candidate opts into SMS communications again, SMS is set as their preferred
communication channel along with email.

If the candidate’s email isn’t present or verified, the hiring team can't send any communications from
Recruiting. However, they can call the candidates for any urgent communications. When the candidate opts into
SMS communications again, SMS is set as their preferred communication channel.

To use this feature, you must configure the Webhook URL in the service provider’s account. You can also configure the
opt-out management feature in Twilio. For details, see the document Candidate Communication on My Oracle Support
(ID 2968395.1).

Related Topics
« Candidate Communication

Set Up Email Notifications for Candidate SMS Replies

Here are the prerequisites and steps to set up email notifications when candidates send SMS replies:

Before you start

Ensure that you've set up two-way SMS communications.

Consider the following info while setting up email notifications:
- You must use a business phone number that supports two-way messaging and not use a short code number.
- This feature currently works with Twilio and Syniverse providers only.

Here's what to do

1. Configure Webhook in the service provider's account.
2. Configure email notification settings when candidates reply to SMS messages.

Configure Webhook for SMS Service Providers

You must configure Webhook in the SMS service provider's account to establish a Webhook connection between
Recruiting and the SMS service provider. To do so, follow these steps:

1. Create a job role in Recruiting.
2. Add the following functional privilege to it:
o Name: Use REST Service - Inbound SMS Webhook
o Code: IRC_REST_SERVICE_ACCESS_INBOUND_SMS_WEBHOOK_PRIV

3. Create a user account for the SMS provider, and add the job role to the account.

The user account that’s set up to access Webhook must not have any other privileges or roles associated with it,
except the job role that you just created.
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4. Apply security roles by running these scheduled processes:
o Import User and Role Application Security Data

o Retrieve Latest LDAP changes

5. Configure the Webhook functionality in the active SMS provider's account. For details, see the document Service
Provider Setup for Two-Way SMS Communications on My Oracle Support (ID 2936718.1).

Related Topics
« Create Roles in the Security Console

- Two-Way Candidate Messaging - Service Provider Setup for Two-Way SMS Communications

Configure Email Notification Settings for Candidate Replies to SMS Messages

When candidates send SMS replies to the hiring team, you can configure whom to notify on the hiring team and when
to notify them.

1. In the Setup and Maintenance work area, go to:
o Setup: Recruiting and Candidate Experience

o Functional Area: Recruiting and Candidate Experience Management
o Task: Recruiting Messaging Configuration

2. Inthe Hiring Team Notification for Text Message Replies section, select Edit.

3. You can choose to notify everyone who had an active SMS conversation with the candidate. You can include
recruiters, hiring managers, or both, for job-application or prospect-based active conversations.

When anyone sends a message from the candidate profile or candidate pools pages, they will receive an email
notification when the candidate replies to their message. It isn't affected by the choices you make using this option.

4. Enter the maximum number of days an SMS conversation between a candidate and a hiring team member is
considered active. For example, let’s say you specify 20 days. If a hiring team member sent an SMS to a candidate in
the last 20 days, and the candidate replied to it, an email notification will be sent to all those hiring team members
who started a conversation with the candidate during this active conversation period. Also, if you choose to notify
recruiters and hiring managers, they will receive an email notification if they're a part of a requisition that’s related to
the active conversation.

The default value for this setting is 15 days and is configured in the predefined profile option
ORA_IRC_INBOUND_SMS_ACTIVE_CONVERSATION_PERIOD.

5. Enter the number of hours within which a reply received from a candidate is considered for sending an email
notification. For example, let’s say you specify 120 hours. If a candidate’s reply SMS is received within this time
frame and is processed by the scheduled process, an email notification will be sent to the hiring team. Let’s say
the candidate sent an SMS message before 120 hours and it was missed during the previous Webhook sync. In this
scenario, when the scheduled process runs next time, it'll bring the SMS message into the application, but won't
trigger an email notification to the hiring team because the reply received from the candidate was before 120 hours.

It's recommended to keep the number of hours setting shorter and lesser than the maximum number of active
conversation days. The default value for this setting is 120 hours and is configured in the predefined profile option
ORA_IRC_INBOUND_SMS_NOTIFICATION_PERIOD.

6. Select Save.

Related Topics
- How do | enable a profile option?
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Email Setup

Workflow to Set Up One-Way Email Communications

Here are the steps to set up one-way email communications in Recruiting, which enables the hiring team to send
outgoing email messages to internal and external candidates.

Required Step
« Enable Vanity Email

Optional Steps

These are optional but recommended steps:
- Enable Alternate Email for Internal Candidate Communications
« Specify the Size Limit for Emails
- Enable Candidates to Unsubscribe from Marketing Emails

« Using Design Templates for Emails

Related Topics
« Profile Options for Messaging

Workflow to Set Up Two-Way Email Communications

Here are the steps to set up two-way email communications when Recruiting Booster is enabled. This enables the hiring
team to send and receive email messages to and from internal and external candidates.

Required Steps

Enable Vanity Email

Opt in to Recruiting Booster

Set Up an Email Messaging Provider

Enable Two-Way Communication for Email

Create the Profile Option to Read Email Messages from a Given Start Date
Configure the No-Reply Email

Set Up a Work Email for Two-Way Email Communication

Run the Scheduled Process for Inbound Messages

PN UAUWN

Optional Steps

Although these steps are optional, it's recommended to complete them:
« Prerequisites for Al Agent Studio
- Enable Candidates to Unsubscribe from Marketing Emails
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Configure Notifications for Candidate Replies to Automated Emails
« Enable Alternate Email for Internal Candidate Communications
« Enable Email Attachments
« Specify the Size Limit for Emails
- Manage File Types for Email Attachments
Using Design Templates for Emails

Related Topics
« Profile Options for Messaging

Workflow to Set Up the Email Assistant

Here are the steps to set up the Email Assistant in Recruiting, which enables the Al Agent to respond to candidate
emails.

The email assistant is available in Oracle Al Agent Studio through the agent template, Recruiting Email Assistant
Template. This template consists of a child workflow called Recruiting Inbox Response Agent and a RAG tool,
Recruiting Knowledge Factory. You need to upload your organization’s policy and process documents in this tool. The
agent workflow refers to these documents for answering candidate emails.

Required Steps

Prerequisites for Al Agent Studio

Configure the Recruiting Email Assistant Template

Upload Documents to the Recruiting Knowledge Factory Tool

Enable the Recruiting Inbox Response Agent

Configure Profile Options for the Email Assistant

Ensure that the Process Recruiting Inbound Messages scheduled process is running periodically to process
incoming messages. For details, see Run the Scheduled Process for Inbound Messages.

CUuPUNA

Set Up One-Way Email Communications

Enable Vanity Email

You can set up one vanity email for your organization. If your organization has multiple career sites, only one vanity
email can be created.

The vanity email address is used to send emails to external candidates, for both one-way and two-way communications.
When two-way communications is enabled, the vanity email is used to send emails to internal candidates as well. When

it isn't enabled, internal candidates receive alert notifications.

Enable the Vanity Email
You need to define the vanity email address and its display name.

1. In the Setup and Maintenance work area, go to:
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o Offering: Recruiting and Candidate Experience
o Functional Area: Recruiting and Candidate Experience Management
o Task: Recruiting Messaging Configuration

Expand the Email Communications section.

In the Vanity Email Configuration section, select Edit.

Select the option, Vanity Email.

Enter the vanity email display name. Example: Vision Inc. Careers
Enter the vanity email address. Example: careers@visioninc.com
Select Save.

NOo uUuhAWN

Note:
« When you change the vanity email, the mailbox name of the email address must be the same as the
active email messaging provider's user name, if you've already set up the email messaging provider. For
example, if the user name of the active email messaging provider is robert.smith, the email address must be
robert.smith@example.com.

- When application-generated messages are sent (such as application confirmation, interview scheduling), they
will have the vanity email display name and vanity email, if the notification configuration hasn't been changed.
When a recruiter sends an email using the Send Message feature, that message will have the recruiter name
(not the vanity email display name and vanity email).

Configure the Vanity Email
You need to set up a Sender Policy Framework (SPF) policy on your domain to ensure that your outbound email is
delivered successfully to the external candidates.

To enable Oracle to send out an email on your behalf, you must set up an SPF policy on your domain as an
authentication mechanism. The exact method of setting up an SPF policy varies from one domain provider to another.
For example, v=spf1include:spf_c.oraclecloud.com ~all. As an example, after this SPF policy changes, the candidate will
receive an email with the "from email" being "Vision Inc. Careers" <careers@visioninc.com>

You must contact your IT department to add the SPF rule when you want to use the Vanity Email. You must add this rule
in your email server to let Oracle's pod email send emails on your behalf.

Set Up Two-Way Email Communications

Enable Vanity Email

You can set up one vanity email for your organization. If your organization has multiple career sites, only one vanity
email can be created.

The vanity email address is used to send emails to external candidates, for both one-way and two-way communications.

When two-way communications is enabled, the vanity email is used to send emails to internal candidates as well. When
itisn't enabled, internal candidates receive alert notifications.
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Enable the Vanity Email
You need to define the vanity email address and its display name.

1. In the Setup and Maintenance work area, go to:

o Offering: Recruiting and Candidate Experience
o Functional Area: Recruiting and Candidate Experience Management
o Task: Recruiting Messaging Configuration

Expand the Email Communications section.

In the Vanity Email Configuration section, select Edit.

Select the option, Vanity Email.

Enter the vanity email display name. Example: Vision Inc. Careers
Enter the vanity email address. Example: careers@visioninc.com
Select Save.

NOo uUuhWN

Note:
- When you change the vanity email, the mailbox name of the email address must be the same as the
active email messaging provider's user name, if you've already set up the email messaging provider. For
example, if the user name of the active email messaging provider is robert.smith, the email address must be
robert.smith@example.com.

- When application-generated messages are sent (such as application confirmation, interview scheduling), they
will have the vanity email display name and vanity email, if the notification configuration hasn't been changed.
When a recruiter sends an email using the Send Message feature, that message will have the recruiter name
(not the vanity email display name and vanity email).

Configure the Vanity Email

You need to set up a Sender Policy Framework (SPF) policy on your domain to ensure that your outbound email is
delivered successfully to the external candidates.

To enable Oracle to send out an email on your behalf, you must set up an SPF policy on your domain as an
authentication mechanism. The exact method of setting up an SPF policy varies from one domain provider to another.
For example, v=spflinclude:spf_c.oraclecloud.com ~all. As an example, after this SPF policy changes, the candidate will
receive an email with the "from email" being "Vision Inc. Careers" <careers@visioninc.com>

You must contact your IT department to add the SPF rule when you want to use the Vanity Email. You must add this rule
in your email server to let Oracle's pod email send emails on your behalf.

Opt in to Recruiting Booster
To enable Recruiting Booster and its functionalities, you first need to opt in to Recruiting Booster.

Before you start
You need these privileges to opt in:

Review Applications Offering (ASM_REVIEW_APPLICATIONS_OFFERINGS_PRIV)
- Configure Oracle Fusion Applications Offering (ASM_CONFIGURE_OFFERING_PRIV)

Here's what to do
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1. Inthe Setup and Maintenance work area, select the Recruiting and Candidate Experience offering.
2. Select Change Feature Opt In.

3. On the Opt In: Recruiting and Candidate Experience page, enable Recruiting Booster.

4. Select Done.

Set Up an Email Messaging Provider
You can set up an email messaging provider that's based on IMAP and uses Basic or Open Authentication. If you're a
Microsoft Office 365 user, you can consider Microsoft Graph over IMAP.

Moving to Microsoft Graph from IMAP has these advantages:

- The Microsoft Graph endpoint lets you access Outlook and many other Office 365 services. For more
information, see this Microsoft documentation: Compare Microsoft Graph and Outlook Endpoints.

- Certificate security support is available for Microsoft Graph.

- Setting up Microsoft Graph also enables Microsoft 365 calendar integration, thereby making the process of
scheduling interviews easier.

Note: Only one email messaging provider can be active at a time.

Choose one of these options to set up the email messaging provider and activate it:
o Configure Microsoft Graph API as Your Email Messaging Provider

o Create an Email Messaging Provider Using IMAP

Configure Microsoft Graph API as Your Email Messaging Provider

Using Microsoft Graph, you can read candidate emails sent to a vanity mailbox that’s set up on Microsoft Office 365.
This support is provided through open authentication using a client secret or client certificate-based credential.

To configure Microsoft Graph API, complete these prerequisites:
- Enable Two-Way Communication for Email
« Enable Vanity Email

Create the Profile Option to Read Email Messages from a Given Start Date
Next, configure Microsoft Graph Al as your active email messaging provider by completing the steps below.

Configure Microsoft Azure Cloud

1. Set up a Microsoft Azure application.

Set up a vanity email with a mailbox on Microsoft Azure.

Set up SPF or DKIM/DMARC on the vanity email domain.

Register the vanity email domain on Google Postmaster and Yahoo CFL (Consumer Feedback Loop).

Configure Graph API in the Microsoft Azure application and update its access policy to prevent the application
from accessing all mailboxes or user profiles.

vihouN

For detailed instructions on configuring these prerequisites, see the technical brief Set Up Microsoft 365 Integration for
Interview Scheduling and Emails (Document ID 2664168.1) on My Oracle Support.

For more information on steps 3 and 4 above, see the technical brief, Implementation of Google/Yahoo Email Sender
Guidelines (Document ID 3053819.1) on My Oracle Support.
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Configure Microsoft Graph API

1. In the Setup and Maintenance work area, go to:
o Offering: Recruiting and Candidate Experience

o Functional Area: Recruiting and Candidate Experience Management
o Task: Enterprise Recruiting and Candidate Experience Information

Expand the Microsoft Graph Integration section and select Edit.
3. Select Enable Email Integration.
4. To reuse the Azure application details that have been configured for calendar integration, select the Use same
authentication configuration as calender integration checkbox. To use a different configuration, complete
these fields:

o Default User Identifier or Email: This must be the same as the vanity email. If you enter the default user

identifier, it should be associated with the same email as the vanity email.
o Application ID: Enter the client ID used in Azure.

o Tenant ID: Enter the unique identifier used for the Azure Active Directory instance in your organization.

o Application Authentication Type: If you select Client Secret, provide the application password. If you
select Certificate, upload the certificate file and provide the certificate password.
5. Select the Delete read emails checkbox if you want the read emails to be automatically deleted. This ensures
that the inbox isn't full and all incoming emails are received.
Select Validate Integration to ensure Graph APl is configured correctly.
Select Save.

N

N o

Activate Microsoft Graph API as the Email Messaging Provider

1. Inthe Setup and Maintenance work area, go to:
o Offering: Recruiting and Candidate Experience

o Functional Area: Recruiting and Candidate Experience Management
o Task: Recruiting Messaging Configuration

2. Expand the Email Communications section.
3. In the Email Messaging Providers section, you'll see Microsoft Graph Integration added. From the Actions
menu (shown as three dots) next to it, select Activate.

Note that you can’t add any other email provider with the same name as Microsoft Graph Integration.

Related Topics
» Configure Email Security

Create an Email Messaging Provider Using IMAP
You can set up an email messaging provider that's based on IMAP and uses Basic or Open Authentication.

Before you start

- Set up SPF or DKIM/DMARC on the vanity email domain.
- Register the vanity email domain on Google Postmaster and Yahoo CFL (Consumer Feedback Loop).

For information on these steps, see the technical brief, Implementation of Google/Yahoo Email Sender Guidelines
(Document ID 3053819.1) on My Oracle Support.

Here's what to do
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1. In the Setup and Maintenance work area, go to:
o Offering: Recruiting and Candidate Experience

o Functional Area: Recruiting and Candidate Experience Management
o Task: Recruiting Messaging Configuration

2. On the Recruiting Messaging Configuration page, in the Email Communications section, select Add.
3. Enter a name and description.
The user name of the active email messaging provider must be the same as the vanity email.
4. The vanity email box will increase in size over time. If you choose to delete emails after they're read, select the Delete
read emails option.
5. Select an authentication type:
o Basic Authentication

o OAuth

6. Based on the authentication type you selected, enter the required info:

o Basic Authentication: Capture the details from your email service provider: IMAP Server, IMAP Port,
User Name, Password. Note: Basic authentication for Office 365 is deprecated. Therefore, use OAuth
authentication.

o OAuth: Email Provider, IMAP Server, IMAP Port, Grant Type, Scope, Tenant ID, Authentication URL, Client
ID, Client Secret, User Name. To use the two-way email messaging capabilities with an Office 365 mailbox,
you need to register an application in Azure AD and set up a service principal in Exchange to enable the
application to access Exchange mailboxes via client credentials flow with the IMAP protocol. For details, see
the technical brief Set Up OAuth for Office 365 Users (ID 2936718.7) available on My Oracle Support.

7. Select Check Connection to make sure that the configuration is properly done.
Select Save and Close.

9. On the Recruiting Messaging Configuration page, in the Email Messaging Providers list, find the provider you added
and set it to Active.

o

Enable Two-Way Communication for Email

When you enable two-way communication for email, you can choose to enable it for external candidates, internal
candidates, or both.

1. In the Setup and Maintenance work area, go to:
o Offering: Recruiting and Candidate Experience

o Functional Area: Recruiting and Candidate Experience Management
o Task: Recruiting Messaging Configuration

2. On the Recruiting Messaging Configuration page, select these options:
o Enable Two-Way Email Communications with External Candidates to enable two-way messaging with
external candidates.
o Enable Two-Way Email Communications with Internal Candidates to enable two-way messaging with
internal candidates.

Note: When you enable two-way email communications for internal candidates, email notifications
related to recruiting will no longer appear in the worklist notification on the global header.

25
ORACLE


https://support.oracle.com/epmos/faces/DocumentDisplay?id=2936718.1&_adf.ctrl-state=13isauiwkd_179&_afrLoop=229269563633202

Oracle Fusion Cloud Talent Management Chapter 1
How do | set up candidate messaging? How do | set up candidate messaging?

Create the Profile Option to Read Email Messages from a Given Start Date

You need to create a profile option called IRC_2_WAY_EMAIL_LAST_SYNC_TIME to read email messages from a given
start date. It represents the last time the email messages are read and processed by Recruiting.

In the Setup and Maintenance work area, select the Tasks icon.

Select Search.

On the Search page, search for the task Manage Profile Options.

. Select the task name.

On the Manage Profile Options page, select the Create icon.

On the Create Profile Option page, create the profile option by entering these values:
o Profile Option Code: IRC_2_WAY_EMAIL_LAST_SYNC_TIME

o Profile Display Name: 2-Way Email Last Sync Time
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o Application: Recruiting

o Module: Recruiting Common

o Description: Define the last sync time for the two-way email communication feature.
o Start Date: Today's date

7. Select Save and Close.

8. You're back on the Manage Profile Options page and the profile option IRC_2_WAY_EMAIL_LAST_SYNC_TIME is
displayed. You need to enable the profile option at the Site level.

9. On the Manage Profile Options page, go to the Profile Option Levels section.
10.Set the profile option to be enabled and updatable at the Site level.
11. Select Save and Close.

12. You need to set profile value for the profile option IRC_2_WAY_EMAIL_LAST_SYNC_TIME to define from when the
email messages are to be read.

13. In the Setup and Maintenance work area, select the Tasks icon.

14.Select Search.

15. Select the Search icon.

16.0n the Search page, search for the task Manage Administrator Profile Values.
17. Select the task name.

18.0n the Manage Administrator Profile Values page, search for the profile option
code IRC_2_WAY_EMAIL_LAST_SYNC_TIME.

19. Set the profile value to yesterday's date, that is Current date - 1. Use the UTC date and time in standard I1SO 8601
format: YYYY-MM-DD HH:MM:SS.

Note: If you don't set a value for this profile option, it'll be set to a default value of 7 days before the current date. If
you haven't created a profile option, then the default value can’t be set and emails won't be processed.

20.Select Save and Close.

Configure the No-Reply Email
It's recommended to configure the no-reply mailbox for automated notifications so that candidate replies aren't tracked.
This is applicable for two-way communications with internal and external candidates.

When you send an email that’s based on a content library template, the email is sent either through the no-reply
email or vanity email, depending on certain factors. Before the 24D upgrade, the Capture Message checkbox in the
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content library template decided whether the notification was sent through the no-reply email or vanity email. After the
upgrade, the following notifications are always sent through the no-reply email, even if they have the Capture Message
checkbox enabled.

Notification Category Code

ORA_CAMPAIGN_OPT_IN_STATEMENT
ORA_CANDIDATE_CONFIRMATION
ORA_CAND_VERIFY_NOTIF
ORA_EVENT_CANC_NOTIFICATION
ORA_EVENT_THANKYOU_NOTIF
ORA_EVENT_UPDATE_NOTIFICATION
ORA_JA_CONFIRMATION
ORA_JOB_ALERT
ORA_OM_CAND_INVITED
ORA_OM_GIG_ASSIGNED
ORA_OM_GIG_CANCELED
ORA_OM_GIG_NOT_APPROVED
ORA_OM_GIG_NOT_SELECTED
ORA_OM_OPPORTUNITY_ALERT

ORA_TALENT_COMMUNITY_CONFIRM

Notification Category Name

Campaign Opt In Statement

Social Campaigns Confirmation Notification
Candidate Verification Notification

Event Canceled Notification

Event Thank You Notification

Event Update Notification

Job Application Confirmation Notification

Job Alert Notification

Opportunity Marketplace Invite Candidate For Gig Notification
Opportunity Marketplace Assigned Gig Notification
Opportunity Marketplace Gig Canceled
Opportunity Marketplace Gig Not Approved
Opportunity Marketplace Gig Not Selected
Marketplace Opportunity Notification

Talent Community Confirmation Notification

Notifications other than the above will be sent through the vanity email, if the Capture Message checkbox is enabled.
They will be sent through the no-reply email, if this checkbox is disabled. However, for some notifications that have this
checkbox enabled, you can override it and send them through the no-reply email.

1. In the Setup and Maintenance work area, go to:
o Offering: Recruiting and Candidate Experience

o Functional Area: Recruiting and Candidate Experience Management
o Task: Recruiting Messaging Configuration
2. Expand the Email Communications section.

3. In the Vanity Email Configuration section, select Edit.
4. Enter the no-reply email address.
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5. In the Send Notifications Using No-Reply Email section, select the notifications that you want to send using the no-
reply email. Even if the Capture Message feature is enabled for these notification categories, emails will be sent only
using the no-reply email once you select them here.

By default, all these notifications are unselected. An unselected notification is sent through the vanity email, only if it
has the Capture Message feature enabled.

6. Select Save.

Related Topics
» What happens when you send a candidate email that’s not based on a content library template?

Set Up a Work Email for Two-Way Email Communication

For two-way email communication to work, the work email must be set as the primary email in the employee's profile
in Person Management. This feature won’t work as intended if any other email, for example, home email, is set as the
primary email. An employee could be any worker who interacts with a candidate.

Go to My Client Groups > Person Management and search for the employee.

From the employee's profile photo, select More Information > Personal and Employment > Person.
In the Communication Methods section, select Email Details from the Edit menu.

Set an existing work email address as primary, or add a work email address, if it doesn't already exist.
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Run the Scheduled Process for Inbound Messages

You need to run the Process Recruiting Inbound Message scheduled process with a 15-minute frequency to see
candidates' SMS and email replies.

From the navigation menu, go to Tools > Scheduled Processes

On the Overview page, select Schedule New Process.

On the Schedule New Process page, select the menu and select Search.
Search for the Process Recruiting Inbound Message process.

Select OK.

On the Process Details page, submit the process.
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Set Up the Email Assistant

Prerequisites for Al Agent Studio

The prerequisites for using Al Agent Studio are:

- Your environment must have the appropriate services for Oracle Applications Platform deployed. For more
information, see FAQ2527 on My Oracle Cloud Support.

- Set the Enable Security Console External Application Integration
(ORA_ASE_SAS_INTEGRATION_ENABLED) profile option to Yes and enable permission groups for the
appropriate roles. See Access Requirements for Al Agent Studio.
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Access Requirements for the Recruiting Inbox Response Agent

The agents you can view depend on the roles and privileges assigned to you. To access the Recruiting Email Assistant
Template and its associated workflows, your role must be explicitly granted access to it by an Al Studio Administrator.
See How can | give users access to Al agents and Access Requirements for Al Agent Studio.

The Recruiting Inbox Response Agent is secured by the following Spectra Authorization Service (SAS) role:
ORA_HCM_IRC_RECRUITING_SCHEDULED_WF_AGENT_ACCESS.

Configure the Recruiting Email Assistant Template

Configure the Recruiting Email Assistant Template to update the email header and signature as needed. You can also
define the schedule for running the email assistant.

Go to Navigator > Tools > Al Agent Studio.

Search for the Recruiting Email Assistant Template.

Select Copy Template.

. Add a suffix to the template. This will get appended to the template name.

You'll see an editable version of this template in the Agent Designer, with the child workflows displayed on the right
pane

Edit the child workflow EmailMessagingAssistantWorkflowNode using the three-dot menu.
On the drawer panel, edit the header and signature in the Input Variables section:
o EmailReplySignature
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o EmailReplyHeader

8. Apply your changes.
9. Select Update on the drawer panel.
10.0n the Agent Designer page, select the Agent Team Settings icon on the menu header.

Here, you can define the schedule for running this agent.
11. On the Triggers tab of the drawer panel, add a schedule.
12. Select the schedule type.

If you select Interval, you can specify how often you want to run this agent, for example every 5 minutes. If you
select Recurrence, you can schedule this as a one-time run or a repeating run.

Note: It's recommended to run the agent for at least every 5 minutes. All times need to be entered in the 24-hour
format in UTC time zone. The end date and end time are optional.

13. Select Update in the Schedule section.
14.Select Update on the drawer panel.
15. Review the agent details in the Agent Designer and publish it.

The agent will start running from the start time you specified in the Schedule section.

What to do next

To change the schedule, signature or header, search for the copy of the template you created on the Agent Teams tab
and edit it.

To stop running the agent, delete the schedule and republish the agent.
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Upload Documents to the Recruiting Knowledge Factory Tool

Upload your organization’s policy and process documents to the Recruiting Knowledge Factory tool. This enables the
Recruiting Inbox Response Agent (email assistant) to refer to them when answering candidate emails.

Go to Navigator > Tools > Al Agent Studio.
On the Tools tab, search for the Recruiting Knowledge Factory tool.
To edit the tool, select the pencil icon in the Actions column.

In the Documents section, add the document that you want the email assistant to refer when answering candidate
questions.

Enter a name for the document and set the document’s status to Ready to publish.
Upload the document and save your changes.

Repeat steps 4 to 6 for each document that you want to upload.

. Save your changes to the tool.

What to do next
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Run the Process Agent Documents scheduled process. When this job completes, the documents will be in Published
status and the email assistant can use them to respond to candidate emails.

Enable the Recruiting Inbox Response Agent
Enable the Recruiting Inbox Response Agent (email assistant) in Recruiting to process and respond to candidate emails.

1. In the Setup and Maintenance work area, go to:
o Offering: Recruiting and Candidate Experience

o Functional Area: Recruiting and Candidate Experience Management
o Task: Recruiting Messaging Configuration

2. Expand the Email Communications section.
3. In the Email Assistant section, select the checkbox, Enable the inbox response agent.

Configure Profile Options for the Email Assistant
You need to configure the following profile options for the Recruiting Inbox Response Agent:

Feature Profile Option Profile Value

Number of minutes to disable the ORA_IRC_2W_EMAIL_AGENT_USERACTION_DISABLE_DURATION Enter the number of minutes. The

Send Reply action while the email default value is 15 minutes.

assistant is processing the email. The Send Reply button will be
enabled once this time elapses.

If you set this value less than the
auto-skip time-out value, then the
email will be available for both the
recruiter and email assistant to
respond because the Send Reply
button will be enabled even while the
agent is processing the email.
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Feature

Number of minutes to wait for the
email assistant to read and process
the email.

This profile option must be created
and then set to the desired value.

Number of email assistant responses
that can be sent across all candidates
in a day.

Number of email assistant responses
that can be sent to a single candidate
in a day.

Related Topics
« Create and Edit Profile Options

Profile Option

IRC_2W_AGENT_AUTO_SKIP_TIMEOUT

ORA_IRC_2W_EMAIL_AGENT_SYSTEM_THROTTLE_LIMIT

ORA_IRC_2W_EMAIL_AGENT_CAND_THROTTLE_LIMIT

Optional Configuration for Email

Enable Candidates to Unsubscribe from Marketing Emails

Chapter 1
How do | set up candidate messaging?

Profile Value

Enter the number of minutes. The
default value is 15 minutes.

If the agent can't reply within this
time, the email is available for the
recruiter to respond.

The default value is 1000.

The default value is 5.

You can classify certain messages as Marketing and provide an option for external candidates to unsubscribe from
them. It's applicable only to emails or certain actions that are taken on multiple candidates at once, from candidate list
views in candidate search, job applications, candidate pools, or prospects pages. When a candidate unsubscribes from
these messages, they'll no longer receive them. This feature isn't applicable to internal candidates.

To classify a message as Marketing, use the Recruiting Messaging Configuration task in Setup and Maintenance and
select the notification templates that have content that can be considered as marketing. The following notification
templates are available to classify as Marketing.

Content Library Templates Available to Classify as Marketing

User Action

Sending bulk messages to more than one
candidate from candidate list views through the
Send Message action.

Adding multiple candidates as prospects to
a requisition from a candidate list, candidate
pools list, events list, or job applications list
through the Add to Requisition action.

ORACLE

Available Content Library Templates

- Prospect Candidate Notification
- Candidate Pool Member Notification
- Candidate Profile Notification

- Event Pool Member Notification

In addition to the above, any user-defined
message (which isn't based on a template) can
also be marked as marketing.

Send Invite Notification

Outcome When Candidates Subscribe to
Marketing Notifications

These bulk messages are sent only to those
candidates who have subscribed to them.
Unsubscribed candidates won't receive them.

Candidates who have subscribed are added as
prospects to the requisition and this notification
is sent to them. Unsubscribed candidates won't
be added as prospects to a requisition and
won'’t receive the notification.
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User Action Available Content Library Templates Outcome When Candidates Subscribe to
Marketing Notifications

Adding multiple candidates to an event froma = Send Event Invite Notification Candidates who have subscribed are added to

candidate list through the Add to Event action. the event and this notification is sent to them.
Unsubscribed candidates won't be added to the
event and won't receive the notification.

Adding a requisition to a candidate pool Candidate Pool Job Notification This notification is sent to all the subscribed
(available in Redwood pages only). candidates in the candidate pool. Unsubscribed
candidates won't receive it.

Note: If you compose a message for a single candidate (from a candidate’s profile page) and it contains one of
the above marketing notifications, or if you perform any of the above actions on a single candidate, that candidate
will continue to receive the marketing notification or get added to a requisition or to an event, even if they earlier
unsubscribed from that notification sent as part of a bulk message.

The marketing emails will include an unsubscribe option in the header along with an unsubscribe link at the end of the
email body, which is visible to candidates. However, when a recruiter previews this email, they can't see the unsubscribe
link or in the sent email on the Messages tab.

The unsubscribe link is available through a new predefined content library item, Marketing Emails Unsubscribe
Notification. This content item provides two tokens, srRerFand unsubscribeLinkURL, Which enables you to add the
unsubscribe link. Currently, it has the following predefined text:

<a ${href}="${UnsubscribeLinkURL}"
target="_blank">Unsubscribe from these emails.

You can create another version of this content item to create your own unsubscribe text.
Here’'s how you classify a notification as marketing:

1. Inthe Setup and Maintenance work area, go to:
o Offering: Recruiting and Candidate Experience

o Functional Area: Recruiting and Candidate Experience Management
o Task: Recruiting Messaging Configuration
2. Scroll down and expand the Marketing Email Notifications section.

3. Select Edit.

4. Select the notification templates that you want to classify as marketing. Note that some of these are selected by
default, which you can change as per your business needs.

5. Select Save.

For more information on email sender guidelines, see the technical brief, Implementation of Google/Yahoo Email Sender
Guidelines (Document ID 3053819.1) on My Oracle Support.

Configure Notifications for Candidate Replies to Automated Emails
If an auto-generated email is sent through the vanity email and candidates reply to them, hiring team members can be
notified using this feature. You can configure who from the hiring team should be notified.

These notifications are received in the hiring team member's work mailbox. The candidates' replies are also displayed in
the Messages tab, only if the Capture Message checkbox is enabled for the auto-generated email.
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Using this configuration, you can't notify hiring team members when candidates reply to:

- Auto-generated emails that are sent from a no-reply email. Hiring team members need to access the no-reply
mailbox to see the candidate replies.

- Any emails that aren't auto-generated (that is, emails composed manually by hiring team members). Hiring
team members need to access the Messages tab to see the candidate replies.

1. In the Setup and Maintenance work area, go to:
o Setup: Recruiting and Candidate Experience

o Functional Area: Recruiting and Candidate Experience Management
o Task: Recruiting Messaging Configuration

2. In the Hiring Team Notification for Replies to Automated Emails section, select Edit.
3. Select the respective check boxes to notify either recruiters or hiring managers or both. By default, both check boxes
are selected. If the email was sent in the context of a candidate pool, the pool owners are also notified.

Let’s say you select both hiring managers and recruiters to receive the email replies. After the candidate sends
their first reply, let’s say you change the configuration to notify only hiring managers and not recruiters. When the
candidate sends subsequent replies to that same email thread, this configuration change won'’t impact the earlier
recipients’ list. Both hiring manages and recruiters will continue to receive the replies for the existing conversations.

Enable Alternate Email for Internal Candidate Communications
You can enable the use of an alternate email address when internal candidates without a work email apply for a job.

Internal candidates without a work email can provide an alternate email address to receive all recruiting notifications
and employee communications. They can enter one alternate email address per job application. They can enter a
different email address if they choose to. Recruiters and hiring managers can see that alternate email address in

the Personal Info section of the candidate profile, in the candidate job application, in the prospect record, and in the
candidate pool member record.

This feature applies to employees and internal contingent workers who don't have a work email. All the communication
is captured in the Messages tab.

Here's what to do

1. Enable the Internal Candidate Alternate Email Profile Option
2. Configure the Use of the Alternate Email Address in the Internal Application Flow
3. Add the Alternate Email Token to the Notification Gateway Alert

Enable the Internal Candidate Alternate Email Profile Option

You first need to configure the use of an alternate email address by enabling the profile option
ORA_IRC_INTERNAL_CAND_ALT_EMAIL_ENABLED at the Site level, using the Manage Administrator Profile Values
task.

1. Inthe Setup and Maintenance work area, select the Tasks icon.

2. Select Search.

3. Search for the task Manage Administrator Profile Values.

4. Select the task name.

5. On the Manage Administrator Profile Values page, search for the profile option code
ORA_IRC_INTERNAL_CAND_ALT_EMAIL_ENABLED.

6. Set the profile value at the Site level to Y.

7. Select Save and Close.
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Configure the Use of the Alternate Email Address in the Internal Application Flow
You now need to configure the use of the alternate email address in the internal application flow.

1.
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Activate a sandbox and page editing at the Site layer in Settings and Actions Menu > Edit Pages > Activate a
sandbox.

On your Home page, go to My Client Groups > HCM Experience Design Studio.

Select the Transaction Design Studio tab.

Select the action Recruiting — Apply to Internal Jobs.

Select Add to create a rule.

In the Basic Details section, enter a name and a description for the rule.

In the Show or Hide Regions section, set Alternate Email to Visible.

Select Save and Close.

Add the Alternate Email Token to the Notification Gateway Alert

You need to add the Alternate Email token to the Notification Gateway alert to send emails to an alternate email address.
This will ensure that the Notification Gateway will use the alternate candidate email when the feature is enabled.
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In the Navigator menu, go to Tools > Alerts Composer.

Search for and open the IRC_Candidate_Notifications_Gateway alert.
In the Edit menu, select Manage Recipients and Message.

Select Add Recipient.

For the communication method, select Mail.

For the expression, add the token ${AlternateCandidateEmail}.

Select Apply.

Save the alert configuration.

Enable Email Attachments

When you use the messaging feature in the Redwood experience for candidate details pages, you can upload
attachments to outgoing emails and receive incoming emails with attachments.

To allow incoming emails with attachments:

1. In the Setup and Maintenance work area, go to:

o Offering: Recruiting and Candidate Experience
o Functional Area: Recruiting and Candidate Experience Management

o Task: Recruiting Messaging Configuration

2. In the Email Messaging Providers section, check whether two-way communications is enabled either for internal or
external candidates, or for both.

3. Select the checkbox, Process email attachments from candidates.

Specify the Size Limit for Emails

You can specify the size limit for incoming and outgoing emails, including their attachments.

1. In the Setup and Maintenance work area, go to:

o Offering: Recruiting and Candidate Experience
o Functional Area: Recruiting and Candidate Experience Management
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o Task: Recruiting Messaging Configuration

2. Select Edit on the Additional Email Settings page.

3. Specify the maximum size limit of an outgoing or incoming email, which includes attachments and the body of the
message. You can decide this limit based on the size of the vanity mailbox. The default value is 20 MB.

Note: Even if incoming messages don't have attachments, they will be rejected if the size of the message body
exceeds the limit specified here.

4. Select Save.

Manage File Types for Email Attachments

As an administrator, you can define which files types are allowed as attachments in incoming emails. The allowed list of
file types is defined in the ORA_IRC_MISC_ATTACH_FILE_TYPES profile option. Unsupported file types are defined in
the ORA_IRC_MISC_ATTACH_UNSUPPORTED_FILE_TYPES profile option.

The list of allowed file types includes these
files: .txt, .rtf, .doc, .docx, .pdf, .htm, .html, .jpeg, .png, .zip, .HEIC, .pptx, .msg, .jpg, .pdf, and .odt. If you haven’t defined
the allowed file types so far, these predefined values will be used.

Both the allowed and unsupported file types are also displayed as part of the Enterprise Recruiting and Candidate
Experience Information task, in the section, Attachments from Candidates.

Related Topics
« How do | enable a profile option?

Using Design Templates for Emails
The feature of applying design templates to one-to-one emails is enabled by default.

To disable it, you need to create the profile option, IRC_REDWOOD_COMPOSE_EMAIL_DISABLE_BRANDING and set it to
Y.

Before you can associate design templates to emails, you must:

1. Create the design templates using the HTML Email templates task in Setup and Maintenance. These templates
can be of type Internal, Global, or AdHoc.

2. Make the templates active.
Emails based on content library templates

When creating a content item based on the following content library categories, associate the AdHoc design template
with it:
- Candidate Profile Notification - ORA_PROFILE_EMAIL_TEMPLATE
- Job Application Notification - ORA_JA_EMAIL_TEMPLATE
Prospect Candidate Notification - ORA_PROSPECT_EMAIL_TEMPLATE
- Candidate Pool Member Notification - ORA_POOL_EMAIL_TEMPLATE
Event Pool Member Notification - ORA_EVENT_POOL_NOTIFICATION_TEMPLATE

Free-form emails
Because free-form emails aren’t associated with a content library item, the global design template is applied, if available.

Language-specific design templates

35
ORACLE


https://www.oracle.com/pls/topic/lookup?ctx=fa-latest&id=u30255926

Oracle Fusion Cloud Talent Management Chapter 1
How do | set up candidate messaging? How do | set up candidate messaging?

To ensure that a language-specific design template is included in the email:

1. Create a design template in the desired language and make it active, using the HTML Email Templates task.
2. Ensure that there’s a translated version of the content library item with which you’ve associated the language-
specific design template.

Related Topics
« HTML Email Templates

- Content Item Versions
« Configure a Career Site

WhatsApp Setup

Workflow to Set Up Two-Way WhatsApp Communications

WhatsApp is available only when the Redwood experience is enabled in Recruiting Booster. Here are the steps to set up
two-way WhatsApp communications, which enables the hiring team to send and receive WhatsApp messages to and
from external candidates.

Required Tasks

Enable Redwood for Messaging in Recruiting
Opt in to Recruiting Booster
Add a WhatsApp Messaging Provider Account
Test Outbound WhatsApp Message
Set Limits for Outbound Messages and Enable WhatsApp Communications
Configure List of Countries to Send WhatsApp Messages
Set Up WhatsApp Templates
a. Create WhatsApp Templates
b. Add Template Translations
c. Send WhatsApp Templates for Approval
d. Associate WhatsApp Templates with Content Library Items
e. Get WhatsApp Template Statuses
8. Configure the Profile Option to Read WhatsApp from a Given Start Date
9. Run the Scheduled Process for Inbound Messages
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Optional Tasks

You can perform these tasks as required:

- Manage WhatsApp Templates
o Search for WhatsApp Templates

o Edit WhatsApp Templates
o Deactivate WhatsApp Templates

« Block Phone Numbers or Phone Number Patterns
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- Extensibility for WhatsApp
« Export and Import WhatsApp Configuration Data

Related Topics
« Profile Options for Messaging

Set Up for Two-Way WhatsApp Communications

Enable Redwood for Messaging in Recruiting

See these topics to enable the Redwood experience in Oracle Cloud HCM. This enables you to take advantage of the
enhanced messaging features in Recruiting:

« Enable your HCM Redwood pages and set up Oracle Search
- Set profile options for Redwood pages

Opt in to Recruiting Booster
To enable Recruiting Booster and its functionalities, you first need to opt in to Recruiting Booster.

Before you start
You need these privileges to opt in:
Review Applications Offering (ASM_REVIEW_APPLICATIONS_OFFERINGS_PRIV)
- Configure Oracle Fusion Applications Offering (ASM_CONFIGURE_OFFERING_PRIV)

Here's what to do

1. In the Setup and Maintenance work area, select the Recruiting and Candidate Experience offering.
2. Select Change Feature Opt In.

3. On the Opt In: Recruiting and Candidate Experience page, enable Recruiting Booster.

4. Select Done.

Add a WhatsApp Messaging Provider Account

You need to add and activate a messaging provider account that can be used for WhatsApp communications. It's
also required to have a WhatsApp Business Account (WABA) set up on the messaging service provider platform. This
business account could be procured through the messaging service provider or directly from Meta.

1. In the Setup and Maintenance work area, go to:
o Offering: Recruiting and Candidate Experience

o Functional Area: Recruiting and Candidate Experience Management
o Task: Recruiting Messaging Configuration
2. In the WhatsApp Messaging Providers section, select Add.

3. Enter a name and description.
4. Select the name of the provider in the Provider list. Currently, Twilio and Syniverse are supported.
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5. The message length limit is preset to 4096 characters for Syniverse and 1600 characters for Twilio.

6. Enter info related to the messaging provider account in the remaining sections. For details, see the document Adding
a WhatsApp Messaging Provider on My Oracle Support (Document ID 3101136.1).

Note: For processing outbound messages, the messaging provider's APl is expected to return the response in
JSON format. To ensure smooth processing of these messages, we recommend that you include the Accept header
in the Headers section and specify its value as application/json.

7. Select Save and Close.

What to do next
Test the outbound WhatsApp message.

Related Topics
» Webhook Configuration for a WhatsApp Messaging Provider

Test Outbound WhatsApp Message

You need to test the WhatsApp messaging provider account to make sure that the configuration is properly done. This
step is done to ensure that messages to candidates are sent successfully.

1. In the Setup and Maintenance work area, go to:
o Offering: Recruiting and Candidate Experience

o Functional Area: Recruiting and Candidate Experience Management
o Task: Recruiting Messaging Configuration

2. Inthe WhatsApp Messaging Providers section, select the name of the active account.
Select Test Outbound Message.

4. Send a test WhatsApp message from your phone number (or any recipient’s phone number) to the provider number
that's shown on the page. If the message fails to be sent on WhatsApp, it could be due to an issue with your internet
connection, the WhatsApp messaging service, or the messaging provider’s service. Complete the steps below within
24 hours of completing this step.

5. Select the checkbox, I've sent a test message to the provider’s number.

6. In the Phone Number field, enter your phone number or the same recipient’s phone number that you used for
sending the test message in step 4. If the phone numbers are different, the message will fail to be sent from the
messaging provider to WhatsApp.

7. Inthe WhatsApp Message field, enter another test message and select Send. If it's sent successfully, the recipient’s
phone number will receive this test message. You can also confirm this by checking the request and response details
in the Sent Message Info section. A status code of 200 in the Response Details section indicates that the message is
successfully sent to the messaging provider. Any other status code indicates a failed message.

W

Note: If the phone number used in step 4 is different from the phone number used in step 6, you'll still see a
status code of 200. However, if you check the status of the response ID number in the messaging provider's
developer’s console, you'll see that the message has failed because the messaging provider wasn't able to send the
message to the recipient’s phone number.

8. Go back to the WhatsApp Messaging Providers list, and set the status of the account you added to Active.

Note: Only one account can be active at a time. You can delete and deactivate other accounts as required.
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Set Limits for Outbound Messages and Enable WhatsApp Communications

Setting limits for outbound WhatsApp messages is useful to limit the volume of outbound WhatsApp messages sent
using third-party services like Syniverse. It also helps limit the cost of usage-based service because these messages are
sent using a WhatsApp business account.

Before you start

- You need to have a WhatsApp messaging provider account in Active status.

+ You also need to set limits for outbound WhatsApp messages sent from Recruiting.

Here's what to do

1. Inthe Setup and Maintenance work area, go to:
o Offering: Recruiting and Candidate Experience

o Functional Area: Recruiting and Candidate Experience Management
o Task: Recruiting Messaging Configuration

2. In the Limit for SMS and WhatsApp Messages section, select Edit.
3. Configure all these options in the WhatsApp Limits column:

o Maximum number of messages that can be sent in a day: This defines the total number of WhatsApp
messages that can be sent from Recruiting in a day across all candidates by different hiring team members.
This is called the system hard limit. All WhatsApp messages that are sent after this limit is reached
are blocked for that day. When this limit is reached, a notification is sent to the administrator. Blocked
messages are never attempted to be sent automatically to the candidate.

o Maximum number of messages that can be sent per candidate in a day: This defines the number of
WhatsApp messages that can be sent to a single candidate in a day by different hiring team members. This
is also called as the candidate message limit. All WhatsApp messages that are sent after this limit is reached
are blocked for that day. Blocked messages are never attempted to be sent automatically to the candidate.

o Number of messages that triggers a warning notification: This defines the number of WhatsApp
messages that can be sent across Recruiting. This is called the system soft limit. After this number is
reached, a warning email is sent to the administrator. This number should be less than the maximum limit
that can be sent in a day.

o Email for notifications: This is the email address to which warning emails are sent. By default, it's auto-
populated with a nonworking email address. You must change it to a valid email address, such as the
administrator's email who can receive the notifications.

Note:

o UTC time zone is considered when counting the limits.
o The system hard limit and candidate message limit are reset to zero at the start of UTC day, at 00:00:00
hours. When the limits are reset, you can send new WhatsApp messages the next day.

o Candidates will be informed through the career site when the system hard limit or the candidate message
limit is reached for the day.

o Recruiters can’t send messages manually when the system hard limit or the candidate message limit is
reached. If automated messages are initiated, they go to the Blocked status.
4. Select Save.

5. On the Recruiting Messaging Configuration page, in the SMS Messaging Providers section, select the option Enable
WhatsApp Communications.
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Configure List of Countries to Send WhatsApp Messages

Using the Recruiting Messaging Configuration task, you can define the list of allowed countries that can receive
WhatsApp messages. This list will be initially empty. You need to add the countries to which you want to send
messages.

If you try to send a WhatsApp message to a country that’s not in this allowed list, it'll be blocked. You can see the
Blocked status against the message in the list view. When you open a blocked message, you can see the reason for the
block. An error message is also displayed to candidates on the career site when they provide a number that's not in this
allowed list.

1. In the Setup and Maintenance work area, go to:
o Offering: Recruiting and Candidate Experience

o Functional Area: Recruiting and Candidate Experience Management
o Task: Recruiting Messaging Configuration
2. Inthe Allowed List of Countries for WhatsApp section, select Edit.

3. Select the Create icon (displayed as +).
4. Select the country from the list that appears.

Note: When you select a country that has the same country code as another country, both countries will be added
to this list. For example, when you select United States, Canada will also be added because it has the same country
code.

5. Select Save.

Set Up WhatsApp Templates

WhatsApp templates enable recruiters to have structured and preapproved conversations with candidates. After
creating WhatsApp templates, you need to send them for approval to Meta, which ensures that the templates are in
compliance with Meta guidelines for WhatsApp messaging.

You create and manage templates using the WhatsApp Notification Template Library task in Setup and Maintenance.
You can also add translations to the templates. These translations also need to be approved by Meta.

A WhatsApp template can be in one of these statuses:
Draft — As soon as a template is created, it's in this status before it's sent for approval to Meta.
Pending Approval — Status when a template is sent for approval to Meta.
- Approved - Status when Meta approves the template.
Rejected - Status when Meta rejects the template.

- Suspended - Meta continuously monitors the template’s contents based on feedback from users. If they get
repeated negative feedback, it could lead to the template being suspended.

Inactive — Status when you manually deactivate templates when they’re no longer needed.

A WhatsApp template is considered active if it's in any status except the Inactive status. As per Meta guidelines, the
maximum number of active templates that can be associated with a WhatsApp Business Account account is 6000. For
the latest updates on this limit, see Related Topics below.

Each WhatsApp template must belong to one of these categories:

Marketing: Marketing templates are designed to achieve organization’s goals of generating awareness or
driving sales.
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Utility: Utility templates enable you to follow up on user actions or requests. For example, if a candidate applies
to a job, you might want to send an acknowledgment message. For this purpose, you can create a template
based on the Utility category.

- Authentication: Authentication templates enable you to verify a user’s identity.

To access the WhatsApp Notification Template Library, you need the privilege
IRC_MANAGE_RECRUITING_CONTENT_LIBRARY_PRIV.

Related Topics
- Meta guidelines for template categories

- Meta templates

Create WhatsApp Templates
You can create WhatsApp templates from scratch or by copying SMS content library templates from the Recruiting

Content Library. When a template is created from scratch, you need to provide the corresponding translations by editing
the template.

When you create WhatsApp templates by copying SMS content templates, all existing content library items that are
used for messaging purposes and have SMS content in them will be considered. If a content library item has any
translations, WhatsApp templates will be created in each of those languages. The WhatsApp templates are also
automatically associated with the content library items from which they were copied.

Copying SMS content templates to create WhatsApp templates should be a one-time activity. After you do this once, the
Copy SMS Content Templates menu item won't be visible on the Ul. However, if you need to do this action again, you
can set the profile option, ORA_IRC_SMS_TEMPLATES_CONTENT_COPIED_TO_WHATSAPP to N. This will enable the
menu item. However, we don’t recommend doing this multiple times because duplicate WhatsApp templates will exist
and you’ll have to manually deactivate the older versions.

WhatsApp templates must follow the WhatsApp business policy of not using promotional, spam, or misleading content.
You can only use plain text in the message. However, you can use tokens for variables like candidate name, job title,
department, and so on.

Note: All templates that you create are associated with your WhatsApp Business Account.

1. In the Setup and Maintenance work area, go to:
o Offering: Recruiting and Candidate Experience

o Functional Area: Recruiting and Candidate Experience Management

2. Select All Tasks from the Show list and then select the WhatsApp Notification Template Library task.
3. Onthe WhatsApp Message Templates page, choose from:
o Select Create Template to create a template from scratch. Then, go to step 4.
o Onthe More Actions menu (shown as three dots) shown next to the page header, select Copy SMS
Content Templates. A confirmation dialog message is shown. Once you confirm, the WhatsApp templates

get automatically created and are listed on the WhatsApp Message Templates page in Draft status with the
current creation date.

A1
ORACLE


https://developers.facebook.com/docs/whatsapp/updates-to-pricing/new-template-guidelines/
https://developers.facebook.com/docs/whatsapp/business-management-api/message-templates/

Oracle Fusion Cloud Talent Management Chapter 1
How do | set up candidate messaging? How do | set up candidate messaging?

4. Enter basic details when creating a template from scratch:
a. Enter a template display name.

b. Enter the template code. This code is sent to Meta and should be as named per their guidelines. So it
should be in English and start with a lowercase letter. The remaining characters can be lowercase letters,
numbers, or underscores. It can’t contain any special characters or uppercase letters.

c. Select a WhatsApp message category that applies to the type of message, whether marketing, utility, or
authentication.

d. Associate the template with a content library category. The template that you want to use for starting a
conversation with a candidate must be associated with the WhatsApp Conversation Starter category.

5. Create the message content:

a. Insert tokens, as required. The type of tokens that are displayed depend on the content library category
that you select. The maximum number of unique tokens you can use is 15. For the WhatsApp Conversation
Starter template, you must insert the MessageBody token.

b. Enter the message content in the Template Message field. You can’t build complex logic into the message
content, for example conditional statements, as per Meta guidelines. The maximum number of characters
you can enter is 1024, including token names.

Note: If you've selected the WhatsApp Message Category as Authentication, you won't be able to insert
tokens or edit the Template Message field.

6. Select Save.
7. After the template is successfully created, you can view it on the WhatsApp Message Templates page.

What to do next
Add translations to the template, if required.

Related Topics
« WhatsApp guidelines for messaging

Add Template Translations

When you create a template in English, corresponding entries will be created for each language installed in your Oracle
Fusion Cloud environment. However, these entries will also be in English. You need to open the entries and add the
translated content to them. The translations aren’t automatically provided. Note that the template must in Draft status
to add translations.

1. Select the template display name on the WhatsApp Message Templates page.

2. Select View Translations on the Actions menu (shown as three dots). The English language template and other
language entries will be displayed on the Template translations drawer.

3. Select Edit Template on the Actions menu next to the language template.
4. Replace the English content with the translated content.
5. Select Save.

What to do next
Send the template and its translations for approval to Meta.

Send WhatsApp Templates for Approval

After a template is successfully created, you need to send it for approval to Meta. The template and its translations,

if available will be sent for approval. Note that the template must be in Draft status for you to send for approval. Meta
might take up to 24 hours to approve a template and its translation. You can send a template for approval only once in
24 hours. If a template is rejected by Meta, you need to create a new template and submit it for approval.
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To send a single template for approval:

1. Select the template on the WhatsApp Message Templates page.
2. Select Send for Approval on the Actions menu (shown as three dots).

To send multiple templates for approval, select them and select the Send for Approval button found above the list of
templates. If you select more than 10 templates, the process might take some time to complete. You'll get a notification
on the global header when it completes. If the templates fail to be sent for approval, it could be due to a network or
REST API issue with the the messaging provider service.

The status of the template will change to Pending Approval. If you view the translations of the template, they will also
show as Pending Approval.

You can periodically check the status of templates to see if the templates are approved. The status will be automatically
updated if Webhook has been set up. If it's not set up, you need to select the Get Latest Template Statuses button. For
details, see the topic Get WhatsApp Template Statuses.

It's quite likely that Meta might not approve some translations of a template, after their evaluation is completed. To
check the approval status of a translation, select the template and select View Translations on the Actions menu. You'll
see the approval status in the Template translations drawer panel.

In case a translation isn't approved, you can need to create another template in English, add the translated content to it
and send it for approval.

Note: At any time, only one Conversation Starter Template can be in Approved or Pending Approval status. Before
submitting the second one for approval, you must deactivate the one that was approved earlier.

If you switch between providers or within the same provider across multiple accounts, after templates have approved,
Oracle doesn't provide support for template migration or synchronization of templates between providers. You may
manage this transition by following these steps:

- Delete the existing templates before switching to another provider or account.
« Switch to the new provider.

- Recreate the templates under the new provider and submit them for approval.

Associate WhatsApp Templates with Content Library Items

After you create a WhatsApp template from scratch and send it to Meta for approval, you need to associate the template
with a content library item before recruiters can start using it for automated and bulk messages.

You don't need to perform this task for WhatsApp templates that are created by copying content library items because
the association is already done at the time of copying.

A template in any status except the Inactive status can be associated with a content library item.

1. In the Setup and Maintenance work area, go to:
o Offering: Recruiting and Candidate Experience

o Functional Area: Recruiting and Candidate Experience Management
o Task: Recruiting Content Library
2. Search for the content item that you want to associate the WhatsApp template with.

3. Open the content item and edit it (if it’s in Draft status) or create a new version of it (if it's active).

4. In the WhatsApp Notification Template list, select the name of the WhatsApp template. Recall that when creating
the WhatsApp template, you had associated it with a content library category. Only those WhatsApp templates that
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belong to the same content library category as the content item that you're editing (or creating a new version of) will
appear in this list. Also, only those translated WhatsApp templates that are in the current language of the application
will appear in this list along with their status.

Note: The WhatsApp template status applies to the selected language template. The status and content can’'t be
changed.

5. Save and activate the content item.

Get WhatsApp Template Statuses

When Webhook is set up, the WhatsApp template statuses are automatically updated and reflected on the WhatsApp
Message Template page. When it isn't set up, use the Get WhatsApp Template Statuses button to track the latest
approval status of templates and sync their statuses with Meta statuses periodically. If you use Twilio as your service
provider, always use this button as the template statuses won't be automatically refreshed otherwise.

If you don'’t perform this task, the templates that are sent for approval will display the Pending Approval status or an
incorrect Active status, even if the template is suspended.

After you select the Get WhatsApp Template Statuses button, it might take a while to see the updated statuses on the
WhatsApp Message Template page. After the process is completed, the statuses will be automatically updated.

To view the approval status of a translation, select the template and select View Translations on the Actions menu
(shown as three dots). You'll see the approval status in the Template translations drawer panel.

Meta might change some WhatsApp message categories (from Marketing to Utility or Authentication, for example)
based on their evaluation. The updated categories will also be visible when you select this button.

For information on setting up Webhook for Syniverse, see Webhook Configuration for a WhatsApp Messaging Provider
(Document ID 3101136.1).

Configure the Profile Option to Read WhatsApp from a Given Start Date

You can configure a profile option called ORA_IRC_2_WAY_WHATSAPP_LAST_SYNC_TIME to read WhatsApp messages
from a specific start date and time.

When you enable two-way WhatsApp communications, this profile option is automatically set to the date and time
when you enabled the feature. The Recruiting application will start processing WhatsApp messages that were received
from that date and time onward.

This profile option is referenced by the Process Recruiting Inbound Message scheduled process, which updates the date
and time automatically to the current date and time when it completes running. So, for example, if the profile option
value was initially set to a date last week, and the scheduled process runs today, WhatsApp messages will be processed
from last week until today. After the scheduled process completes running, it'll set the profile option value to today's
date. This will ensure that messages will be read from today onward, when the scheduled process runs next time.

If you need to read WhatsApp messages from a different date and time, you can manually update this profile option
value. This set up step is optional.

In the Setup and Maintenance work area, select the Tasks icon.

Select Search.

On the Search page, search for the task Manage Administrator Profile Values.
Select the task name.

On the Manage Administrator Profile Values page, search for the profile option
code IRC_2_WAY_WHATSAPP_LAST_SYNC_TIME.

A WN B
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6. Set the profile value to the desired start date and time from which WhatsApp messages should be read. It's
recommended to set this value to five days before the current date. Use the UTC date and time in standard ISO 8601
format: YYYY-MM-DD HH:MM:SS to enter the value.

7. Select Save and Close.

Run the Scheduled Process for Inbound Messages

You need to run the Process Recruiting Inbound Message scheduled process with a 15-minute frequency to see
candidates' SMS and email replies.

From the navigation menu, go to Tools > Scheduled Processes

On the Overview page, select Schedule New Process.

On the Schedule New Process page, select the menu and select Search.
Search for the Process Recruiting Inbound Message process.

Select OK.

On the Process Details page, submit the process.

oUv A UN R

Optional Configuration for WhatsApp

Manage WhatsApp Templates

Using the WhatsApp Notification Template Library task in Setup and Maintenance, you can also:

- Search for WhatsApp templates based on filters and keyword search.
Edit WhatsApp templates.
Deactivate templates when they’re no longer needed.

- View the following template metrics in the header area:
o Number of active templates

o Number of approved templates

o Number of rejected templates

o Number of suspended templates

o Number of draft templates

o Number of templates in pending approval status
o Number of templates used in the content library

o Number of recently updated templates (those updated in the last 7 days)

These metrics include translated templates as well. So, if an active template exists in 2 translations, the total
count is taken as 2 for that template. Deactivated templates aren’t included in template metrics.

Search for WhatsApp Templates
You can search for WhatsApp Templates on the WhatsApp Message Templates page by one of these methods:

- Type a template name in the Search box.

Filter based on the status, content library category, or WhatsApp message category.
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If you type a template name in the Search box and also apply a filter, say for example, Approved status, you'll see a list
of templates that match your template name and are in Approved status.

The Number of approved translations column displays the number of translations that were approved out of the total
number sent to Meta.

Selecting a template name displays the details of the template and its approval status. If a template is suspended or
rejected by Meta and they’ve provided a reason for it, that'll also be displayed.

When you filter templates based on the status, content library category, or WhatsApp message category, the count of
templates is automatically updated in all metrics.

Edit WhatsApp Templates
You can edit templates or template translations only if they're in Draft status.

To edit a WhatsApp template, select the template display name on the WhatsApp Message Templates page and select
Edit in the Template details drawer.

You can't edit approved or rejected templates or template translations. If you need updated versions, we recommend
this approach:

- Create a new template and submit it for approval.
- After the new template is approved, deactivate the previous template.

- Associate the newly approved template with the relevant content library item using the Recruiting Content
Library task.

To edit the translated version of a template in Draft status, select the template, and select View Translations on the
Actions menu (shown as three dots). In the Template translations drawer, select Edit Template on the Actions menu
next to the other language version. Replace the existing content with the updated content and select Save.

You'll also see a Send for Approval option on the Actions menu, which enables you to send individual translations for
approval.

Deactivate WhatsApp Templates

You can deactivate a WhatsApp template in any status except the Inactive status. When you deactivate a template, its
translated versions are also deactivated. The deactivated templates will be removed from Meta and its status will be
marked as Inactive in Recruiting.

To deactivate a template, select it on the WhatsApp Message Templates page and select Deactivate on the Actions
menu.

To deactivate multiple templates at once, select the templates and select the Deactivate button found above the list of
templates. If you select more than 10 templates, the process might take some time to complete. You'll get a notification
on the global header when it completes.

Block Phone Numbers or Phone Number Patterns

You can prevent sending SMS or WhatsApp messages to unauthorized phone numbers by blocking those numbers
or by blocking those numbers that match a specific pattern. After you add the blocked list, any SMS or WhatsApp
messages that are sent to these numbers or patterns will be blocked in Recruiting. You can see the Blocked status and
the reason for the block when you open the SMS or WhatsApp message.

An error message is displayed to candidates on the career site when they provide a number that's on the blocked
numbers and patterns list.
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To enable this feature, you need to add the phone numbers or phone number patterns to a CSV file, compress the file,
and then upload it using the Recruiting Messaging Configuration task.
These are the specifications of the CSV file:
Each compressed file should contain only one CSV file.
- The file size must not exceed 2 MB.
- You must upload separate files, one for phone numbers and another for phone number patterns.

Here are a few things to consider about the file used for uploading phone numbers:
- The CSV file must contain only one column and it must not be empty.
If the phone number contains a + sign or a comma or brackets, you must enclose them within double quotes.

« The phone number must include the country code and area code.

Here are a few things to consider about the file used for uploading phone number patterns:
- The CSV file must contain only one column and it must not be empty.

- You need to use regular expression patterns for phone number patterns. For example, to block phone numbers
beginning with 1800, use a regular expression such as 1800. *

Note: Using this task, you can also unblock phone numbers or phone number patterns that were blocked earlier.

1. Inthe Setup and Maintenance work area, go to:
o Offering: Recruiting and Candidate Experience
o Functional Area: Recruiting and Candidate Experience Management
o Task: Recruiting Messaging Configuration
2. If you haven't uploaded phone numbers or phone number patterns so far, you can download a sample file from the
downloadable links available in the Block Phone Numbers or Patterns section. Next, select Edit in this section.
3. From the Manage Phone Numbers or Patterns list, select one of these options:
o Add Phone Numbers: Block phone numbers.
o Add Patterns: Block phone number patterns.
o Delete Phone Numbers: Unblock phone numbers.
o Delete Patterns: Unblock phone number patterns.
4. For each of the above actions, upload a separate CSV file that contains the numbers or patterns. So if you're using a
CSV file to block some phone numbers, you must upload a different CSV file for unblocking some phone numbers.

If you'd blocked some phone numbers earlier, the new phone numbers that you upload now will get added to the
blocked list.

5. Select Save.

What to do next

You can also download the list of blocked phone numbers or phone number patterns by selecting the respective
download links. For SMS messages, you can generate a report from the Reports for Text Messages section in this task to
understand how many SMS messages were blocked per country.

In the Redwood version of Recruiting, you can resend blocked SMS messages, if you unblock the phone numbers or
phone number patterns.
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Extensibility for WhatsApp

WhatsApp messages and the WhatsApp filter can be shown or hidden in Message Center using a Visual Studio page
property, showWhatsApponMessageCenter. For more details, see How do | control the display of a Ul element in Visual
Builder Studio?.

Export and Import WhatsApp Configuration Data
You can export the following WhatsApp configuration details from one application environment and import them into
another:
Name and description of WhatsApp messaging providers
- Allowed list of countries for WhatsApp

Daily limits for WhatsApp messages, which includes the system hard limit, candidate message limit, and the
system soft limit

These details are exported as a CSV file. When you import the details, the following changes occur in the destination
environment:

- WhatsApp messaging providers that are in the CSV file are added to the existing list of WhatsApp providers.

- The allowed list of countries and daily limits for WhatsApp messages are replaced with the corresponding data
from the CSV file.

Note that the existing functionality for exporting and importing of SMS configuration details remain the same. So, when
you perform the export and import tasks, the SMS configurations in the destination environment are also updated as
follows:
- SMS providers from the imported data are added to the existing list of providers
Daily limits for SMS are replaced by the imported data
- Allowed list of countries for SMS are also updated with the imported data

Export WhatsApp Configuration Data

1. In the Setup and Maintenance work area, go to:
o Offering: Recruiting and Candidate Experience
o Functional Area: Recruiting and Candidate Experience Management
o Task: Recruiting Messaging Configuration
2. From the Actions menu (marked by a down arrow), select Export to CSV > Create New.

Note: If you don’t see the Actions menu, enable it from the View menu by selecting Columns > Actions.

3. Edit the process name and description, as required.

4. Submit the process.

5. After a few minutes, select the Export to CSV option from the Actions menu again.
6. Select Ready for Download.

7. On the Export Setup Data to CSV File Results page, select Download File.

The CSV file is downloaded to your local folder as a compressed file.

Import WhatsApp Configuration Data
To import the WhatsApp configuration details into the destination environment:

1. Open the destination environment.
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2. From the Actions menu (marked by a down arrow) next to the Recruiting Messaging Configuration task, select
Import from CSV > Create New.

Select the compressed CSV file that was downloaded.
Submit the process.

5. To check whether the process has completed successfully, look for the Ready for data validation option on the
Import from CSV menu.

6. Select the Recruiting Messaging Configuration task to check whether the configuration details are imported
successfully.

P W

Enable Candidates to Opt Out of WhatsApp Communications

Candidates have the flexibility to opt in or opt out of WhatsApp communications. To stop receiving WhatsApp
messages, they can send a message with a STOP keyword or similar in the WhatsApp thread that they're
communicating with hiring team members. To resume receiving messages, they can send a message with a START
keyword or similar in the same thread.

These predefined profile options that are currently available for SMS can also be used for WhatsApp. The keywords sent
by the candidate to start or stop WhatsApp messages are validated against these profile values.

Profile Options for WhatsApp Communications

Profile Option Default Values

ORA_IRC_CAND_SMS_OPTOUT_PATTERN = STOP, STOPALL, UNSUBSCRIBE, CANCEL, END, QUIT

ORA_IRC_CAND_SMS_OPTIN_PATTERN START, UNSTOP

Note: This feature uses the Webhook functionality. The Webhook used for reading incoming WhatsApp messages

is used for the opt-out feature as well. The configured Webhook sends all incoming messages from candidates to
Oracle Recruiting, which in turn validates the messages against the opt-out profile values. If it finds a match, any new
messages from Recruiting aren't sent to the respective candidates. For details about configuring the opt-out feature,
see Webhook Configuration for WhatsApp Messaging Providers.

Communication Channel Preferences

When a candidate opts out, WhatsApp is removed as a preferred communication channel from the candidate's profile.
If the candidate's email is verified and preferred, the email will continue to be used for communications. If it's verified
but not preferred, it's set as the preferred channel and a notification is sent to the candidate about this change. A new
content library template is now available for sending this notification:

- Category: Candidate Opt-out Notification (ORA_CAND_OPTOUT_UPDATE_EMAIL)
- Content ltem Name: Email Notification To Candidate for Updated Communication Channel from WhatsApp
- Code: WA_OPTOUT_CAND_COMM_PREF_UPD

In the meantime, they can also set SMS as their preferred communication channel. If the candidate sends START again
to resume WhatsApp communications, it's added back as their preferred communication channel along with email.

Related Topics
- Enable Candidates to Opt Out of SMS Messages
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Message Center Setup

Workflow to Set Up Message Center
Message Center is available only when the Redwood experience is enabled in Recruiting Booster.
Before you start
Set up these communication channels as per your business needs:
« Set Up Two-Way SMS communications

« Set Up Two-Way Email Communications

« Set Up Two-Way WhatsApp Communications

Next, complete these steps to configure Message Center:

Here's what to do

1. Enable Redwood for Messaging in Recruiting

2. Access Privileges and Profile Option for Message Center
3. Run Scheduled Processes for Message Center

4. Optional Configuration for Message Center

Related Topics
« Profile Options for Messaging

Enable Redwood for Messaging in Recruiting

See these topics to enable the Redwood experience in Oracle Cloud HCM. This enables you to take advantage of the
enhanced messaging features in Recruiting:

« Enable your HCM Redwood pages and set up Oracle Search
- Set profile options for Redwood pages

Access Privileges and Profile Option for Message Center

Complete these steps:
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1. Grant the Access Recruiting Message Center privilege (IRC_ACCESS_RECRUITING_MESSAGE_CENTER) to the
recruiter and hiring manager role with the respective aggregate privilege:

o Access Recruiting Message Center as Recruiter
(ORA_IRC_ACCESS_RECRUITING_MESSAGE_CENTER_AS_RECRUITER)

o Access Recruiting Message Center as Hiring Manager
(ORA_IRC_ACCESS_RECRUITING_MESSAGE_CENTER_AS_HIRING_MANAGER)

2. To view the Compose button, the privilege IRC_INTERACT_WITH_CANDIDATE_PRIV is required. It's already added to
these roles:

o ORA_IRC_HIRING_MANAGER_ABSTRACT
o ORA_IRC_RECRUITER_JOB
If you're creating a custom role, ensure that you add this privilege to the role.

3. Enable the profile option, ORA_IRC_MESSAGE_CENTER_ORACLE_SEARCH_ENABLED. For details, see How do |
enable a profile option?.

Related Topics
 Profile Options for Messaging

Run Scheduled Processes for Message Center

Run these scheduled processes:

1. Run this scheduled process once for the first time and later as needed. It's not required to schedule it on a recurring
basis. You must run it if you change the timespan for displaying past messages, for example, from 90 days to 120
days.

o ESS job to create index definition and perform initial ingest to OSCS
o Index Name to Reingest: fa-hcm-irc-messages

2. Run the Process Recruiting Inbound Message scheduled process as needed.

Optional Configuration for Message Center

You can optionally specify these configuration options for Message Center.
« Configure the Time Span for Displaying Messages
« Enable Al Assist in Message Center
« Improve the Performance of Message Center

View the Compose Button in Message Center

Configure the Time Span for Displaying Messages

Configure the time period from which messages must be displayed in Message Center. The default is set to 180 days in
the past.

1. Inthe Setup and Maintenance work area, go to:
o Offering: Recruiting and Candidate Experience
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o Functional Area: Recruiting and Candidate Experience Management
o Task: Recruiting Messaging Configuration

2. Scroll down to the Message Center Settings section, and enter the number of past days to display messages
from. The maximum number allowed is 365 days.

Enable Al Assist in Message Center
You can use Al Assist while composing and replying to emails using Message Center.

To use Al Assist while replying to emails and to view the email summary before sending a reply, you need to enable the
profile option, HCM_GENAI_IRC_REPLY_MESSAGE_ENABLED.

To use Al Assist while composing emails, you need to enable the profile option,
HCM_GENAI_IRC_COMPOSE_MESSAGE_ENABLED.

For details, see How do | enable Al Assist while composing messages or replying to candidates?

Improve the Performance of Message Center
To improve the performance of the Message Center, these profile options are available. If required, you can change their
values:

Message Center Requisition Batch Size (ORA_IRC_MSGCNTR_OSCS_REQ_BATCH_SIZE): The number of
requisitions to fetch per batch from Oracle search. The default is 10,000 per batch, which is the maximum value
that can be set.

Message Center Requisition Maximum Limit (ORA_IRC_MSGCNTR_OSCS_REQ_IDS_MAX ): The maximum
number of requisitions to fetch from Oracle Search and display in the Message Center per user. The maximum
value should be 30000. The default value is 10000.

View the Compose Button in Message Center

To view the Compose button, the privilege IRC_INTERACT_WITH_CANDIDATE_PRIV is required. It's already added to
these roles:

» ORA_IRC_HIRING_MANAGER_ABSTRACT
« ORA_IRC_RECRUITER_JOB

If you're creating a custom role, ensure that you add this privilege to the role.

Enable Recruiters to View All Messages

When recruiters apply the All messages or Sent by others filters, they can't see emails for a candidate if they don't
have access to all the associated contexts. However, they can see all SMS messages if they have access to at least one of
the contexts associated with the messages. However, you can provide them with unrestricted access to these messages
through a profile option, ORA_IRC_MSG_CENTER_SEARCH_VIEW_UNRESTRICTED.

When you enable this profile option, recruiters can:

- View the list of all emails, SMS, and WhatsApp messages for all requisitions, pools, and events that they have
access to. Otherwise, they can only view messages from the most recently modified 10,000 requisitions, 5000
pools, and 5000 events.

- View the list of all emails, SMS, and WhatsApp messages in the context of candidate profiles, prospects,
submissions, events, or pools that they don’t have access to.
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Note: While recruiters can view these messages in the search results list on the left panel, they can view the message
details on the right panel, only if they have access to the candidate and associated contexts.

This profile option enhances the search performance of the Message Center and provides a unified experience across
the Messages tab and Message Center.

A few points to consider while enabling the profile option:

By default, this profile option is set to N at the site level. If recruiters in your organization have access to all
requisitions, pools, and events, it's recommended to set the site level value to Y. To provide access to only some
users, you can set the user-level value to N for those users. This will override the site-level value.

Unrestricted data access is provided only for the search feature but not for the contexts.

- The values previously set in these two profile options will be ignored:
o ORA_IRC_MSGCNTR_OSCS_REQ_BATCH_SIZE (Message Center Requisition Batch Size)

o ORA_IRC_MSGCNTR_OSCS_REQ_IDS_MAX (Message Center Requisition Maximum Limit)

Extensibility for Message Center
You can enable or disable these features in Message Center using the following Visual Basic page properties:

- enableReplyonMessageCenter — This enables the Reply button on emails and SMS messages.
- showGoToCandidateProfile — This enables the Go to Candidate Profile button on these pages.

- showSMSonMessageCenter — This enables the display of SMS messages in Message Center. When it’s disabled,
the SMS filter option is also hidden.

- showGenAIEmailSummary — This enables the display of the email summary section generated by Al. Even
if you've enabled Al Assist for replying to emails, you can still disable the email summary section using this
property. This won't impact the use of the Al Assist button while composing the email reply.

- showVisitorMessagesOnMessageCenter — This enables the display of visitor messages and the Text Assistant
replies to their messages in Message Center.

Related Topics
« How do | control the display of a Ul element in Visual Builder Studio?

Profile Options for Messaging

Profile options used in candidate messaging are summarized in this table.
Profile Options for Messaging

Feature Profile Option Profile Value
View the Redwood job application details page. ~ORA_IRC_RECRUITING_REDWOOD_ENABLED Y

ORA_IRC_REQUISITION_REDWOOD_ENABLED
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Feature

Read SMS messages from a specific start date
and time.

Read email messages from a given start date
and time.

Read WhatsApp messages from a given start
date and time.

Compose messages using Al Assist from the:

- Candidate profile page (Messages tab)

«  Message Center

Reply to candidate messages using Al Assist
and also generate the conversation summary
when replying to messages in the Message
Center.

Send messages to multiple candidates using Al
Assist.

Type of email attachments that are allowed.

Type of email attachments that aren’t allowed.

Enable the search feature in Message Center.

The number of requisitions to fetch per batch
from Oracle search and display in Message
Center.

The maximum number of requisitions to fetch
from Oracle Search and display in the Message
Center per user.

Gain unrestricted access to messages when you
apply the All messages or Sent by others filters.

Stop receiving SMS messages.

ORACLE

Profile Option

ORA_IRC_2_WAY_SMS_LAST_SYNC_TIME

IRC_2_WAY_EMAIL_LAST_SYNC_TIME

ORA_IRC_2_WAY_WHATSAPP_LAST_SYNC_
TIME

HCM_GENAI_IRC_COMPOSE_MESSAGE_
ENABLED

HCM_GENAI_IRC_REPLY_MESSAGE_ENABLED

HCM_GENAI_IRC_SEND_MESSAGE_ENABLED

ORA_IRC_MISC_ATTACH_FILE_TYPES

ORA_IRC_MISC_ATTACH_UNSUPPORTED_
FILE_TYPES

ORA_IRC_MESSAGE_CENTER_ORACLE_
SEARCH_ENABLED

ORA_IRC_MSGCNTR_OSCS_REQ_BATCH_SIZE

ORA_IRC_MSGCNTR_OSCS_REQ_IDS_MAX

ORA_IRC_MSG_CENTER_SEARCH_VIEW_
UNRESTRICTED

ORA_IRC_CAND_SMS_OPTOUT_PATTERN
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Profile Value

Use the UTC date and time in standard ISO
8601 format: YYYY-MM-DD HH:MM:SS. It's
recommended to set this value to five days
before the current date.

Set the profile value to yesterday's date, that
is Current date - 1. Use the UTC date and time
in standard ISO 8601 format: YYYY-MM-DD
HH:MM:SS.

If you don't set a value for this profile option,

it'll be set to a default value of 7 days before the
current date.

Use the UTC date and time in standard ISO 8601
format: YYYY-MM-DD HH:MM:SS to enter the
value. It's recommended to set this value to five
days before the current date.

Y

Existing file types include .txt, .rtf, .doc, .docx,
.pdf, .htm, .html, .jpeg, .png, .zip, .HEIC, .pptx,
.msg, .jpg, -pdf, and .odt.

Change them as required in the same format.

Enter as required in the same format as allowed
file types.

Y

The default is 10,000 per batch, which is the
maximum value that can be set.

The maximum value should be 10000. The
default value is 10000.

STOP, STOPALL, UNSUBSCRIBE, CANCEL, END,
QUIT
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Feature

Start receiving SMS messages.

Configure the use of an alternate email address
for internal candidates.

Number of minutes to disable the Send Reply
action while the email assistant is processing
the email.

Number of minutes to wait for the email
assistant to read and process the email.

This profile option must be created and then
set to the desired value.

Number of email assistant responses that can
be sent across all candidates in a day.

Number of email assistant responses that can
be sent to a single candidate in a day.

Related Topics

Profile Option

ORA_IRC_CAND_SMS_OPTIN_PATTERN

ORA_IRC_INTERNAL_CAND_ALT_EMAIL_
ENABLED

ORA_IRC_2W_EMAIL_AGENT_USERACTION_
DISABLE_DURATION

IRC_2W_AGENT_AUTO_SKIP_TIMEOUT

ORA_IRC_2W_EMAIL_AGENT_SYSTEM_
THROTTLE_LIMIT

ORA_IRC_2W_EMAIL_AGENT_CAND_
THROTTLE_LIMIT

» How do | enable a profile option?
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Profile Value

START, UNSTOP

Enter the number of minutes. The default value
is 15 minutes.

The Send Reply button will be enabled once
this time elapses.

If you set this value less than the auto-skip
time-out value, then the email will be available
for both the recruiter and email assistant to
respond because the Send Reply button will be
enabled even while the agent is processing the
email.

Enter the number of minutes. The default value
is 15 minutes.

If the agent can't reply within this time, the
email is available for the recruiter to respond.

The default value is 1000.

The default value is 5.

» How do | enable Al Assist while composing messages or replying to candidates?

ORACLE
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